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Disclaimer

The information contained in this manual is the property of Netcom Systems, Inc. and is furnished for use by
recipient only for the purpose stated in the Software License Agreement accompanying the user documentation.
Except as permitted by such License Agreement, no part of this publication may be reproduced, stored in a retrieval
system, or transmitted, in any form or by any means, without the prior written permission of Netcom Systems, Inc.

Information contained in the user documentation is subject to change without notice and does not represent a
commitment on the part of Netcom Systems, Inc. Netcom Systems, Inc. assumes no responsibility or liability for any
errors or inaccuracies that may appear in the user documentation.

Trademarks

SmartBits is a trademark of Netcom Systems, Inc.

Warranty

Netcom Systems, Inc. warrants to recipient that hardware which it supplies with this user documentation (“Product”)
will be free from significant defects in materials and workmanship for a period of twelve (12) months from the date of
delivery (the “Warranty Period”), under normal use and conditions.

Defective Product under warranty shall be, at Netcom Systems’ discretion, repaired or replaced or a credit issued to
recipient’s account for an amount equal to the price paid for such Product provided that: (a) such Product is returned to
Netcom Systems after first obtaining a return authorization number and shipping instructions, freight prepaid, to Netcom
Systems’ location in the United States; (b) recipient provide a written explanation of the defect claimed; and (c) the
claimed defect actually exists and was not caused by neglect, accident, misuse, improper installation, improper repair,
fire, flood, lightning, power surges, earthquake or alteration. Netcom Systems will ship repaired Product to recipient,
freight prepaid, within ten (10) working days after receipt of defective Product. Except as otherwise stated, any claim on
account of defective materials or for any other cause whatsoever will conclusively be deemed waived by recipient
unless written notice thereof is given to Netcom Systems within the Warranty Period. Product will be subject to
Netcom Systems’ standard tolerances for variations.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, ALL IMPLIED WARRANTIES, INCLUDING BUT
NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NONINFRINGEMENT AND
FITNESS FOR A PARTICULAR PURPOSE, ARE HEREBY EXCLUDED, AND THE LIABILITY OF NETCOM,
IF ANY, FOR DAMAGES RELATING TO ANY ALLEGEDLY DEFECTIVE PRODUCT SHALL BE LIMITED
TO THE ACTUAL PRICE PAID BY THE PURCHASER FOR SUCH PRODUCT. IN NO EVENT WILL
NETCOM SYSTEMS BE LIABLE FOR COSTS OF PROCUREMENT OF SUBSTITUTE PRODUCTS OR
SERVICES, LOST PROFITS, OR ANY SPECIAL, DIRECT, INDIRECT, CONSEQUENTIAL OR INCIDENTAL
DAMAGES, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, ARISING IN ANY WAY OUT OF
THE SALE AND/OR LICENSE OF PRODUCTS OR SERVICES TO RECIPIENT EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES AND NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE
OF ANY LIMITED REMEDY.
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About this Guide
What’s in this chapter

This portion of the user guide contains the following sections:

Section 1: Purpose

Section 2: Audience

Section 3: Manual Content

Section 4: Conventions Used in This Guide

Section 5: Related Manuals

Section 6: Online Help

Section 7: Technical Support
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About this Guide
Purpose
Purpose
This user guide provides information on all procedures required to perform tests using
SmartApplications 2.30 application software. This includes details on software
installation, test setup, and test result interpretation.

Audience
This user guide is for users of SmartApplications 2.30 software. It is assumed that users of
this guide are familiar with Microsoft Windows and SmartBits equipment, and have an
intermediate knowledge level of data communications theory.
SmartApplications User Guide



About this Guide
Manual Content
Manual Content
This guide contains the following chapters:

Chapter 1, “SmartApplications Overview.” Provides an overview of
SmartApplications.

Chapter 2, “Basic Test Theory.” Explains general SmartApplications
theory of operation and testing rules.

Chapter 3, “Install and Connect.” Lists system requirements and explains
how to connect your PC to a SmartBits
and DUT.

Chapter 4, “Basic Navigation and Tools.” Describes the SmartApplications main
window and results windows, including
their menus and task buttons.

Chapter 5, “Set Up Tests.” Explains procedures that are required to
set up any SmartApplications test.

Chapter 6, “Run Tests.” Explains procedures to start, stop, and
run tests, and view reports.

Chapter 7, “Test Scenario.” Provides example test scenarios and
explains test results.
SmartApplications User Guide 3
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About this Guide
Conventions Used in This Guide
Conventions Used in This Guide
This guide uses the following conventions:

• Italics are used for document names and special terms.

• Menu options, field names, and tab names are bolded.

• Paths are shown with “greater than” symbols. For example, for Test > Setup Options
> Throughput. In this example, you would click on the Test menu option, then on
the Setup Options selection, and then on the Throughput tab.

• Notes are delineated by horizontal lines:

Note: Notes include related information, tips, and precautions about the topic preceding
them.

Related Manuals
Additional manuals related to this SmartApplications User Guide are listed below:

• SmartBits Getting Started

• SmartBits System Overview and Reference

• Using GPS with SmartBits

Online Help
SmartApplications provides online Help for all windows and tabs. You can access online
Help in two ways:

• Press the F1 key from the window about which you wish information.

• From the menu bar, select Help > Contents to view the entire contents of the Help
file or Help > Search for Help On to search by a specific topic or word.

Chart Facility Help

SmartApplications includes a chart facility for graphically representing test results. It
contains a separate Help file titled First Impression. If you can access Help from a chart-
related window in either of the ways listed above, you will view chart-related Help only.
Once you return to the Results window, you can view SmartApplications Help.
SmartApplications User Guide



About this Guide
Technical Support
Technical Support
Technical support is available Monday through Friday between 07:00 and 18:00 Pacific
Standard Time.

To obtain technical support for any Netcom Systems product, please contact our Technical
Support Department using any of the following methods:

Phone: 800 886-8842 (available in the U.S. and Canada)
818 676-2589

Fax: 818 880-9154

E-mail: support@netcomsystems.com

In addition, the latest versions of application Help files, application notes, and software
and firmware updates are available on our website at:

http://www.netcomsystems.com

Netcom Systems Headquarters

Netcom Systems, Inc.
26750 Agoura Road
Calabasas, CA 91302 USA
818 676-2300
SmartApplications User Guide 5
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 SmartApplications Overview
What’s in this Chapter

This chapter contains the following sections:

Section 1: What is SmartApplications

Section 2: What are SmartCards, SmartModules and MiniModules
SmartApplications User Guide 7
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Chapter 1: SmartApplications Overview
What is SmartApplications
What is SmartApplications
SmartApplications is an easy-to-use suite of tests for LAN switches and routers
connecting to Ethernet, Token Ring, Frame Relay, and/or Token Ring networks. With
SmartApplications, you can test devices with up to 768 ports.

You can test how well a device performs with either packet-based or stream-based
network traffic that is simulated by SmartBits SmartCards. These tests are based on:

• RFC 1242, Benchmarking Terminology for Network Interconnection Devices, edited
by Scott Bradner (sob@harvard.edu)

• An informational document Benchmarking Methodology for Network Interconnect
Devices, edited by Scott Bradner

• RFC 2544, Benchmarking Methodology for Network Interconnect Devices, edited by
Scott Bradner and Jim McQuaid (mcquaidj@netscout.com)

RFC 1242 and RFC 2544 outline the following SmartApplications tests for network
devices:

• Throughput

• Latency

• Frame Loss Rate

• Back-to-Back

RFC 1242 contains a complete definition of the terms for which the tests are named. RFC
2544 describes how to measure and test performance, including specific formats in which
to report test results and maximum frame rates to use with specific frame sizes.

Both RFCs are included in an appendix to the SmartBits System Overview manual, and
RFC 1242 and the informational document are also available at the NDTL ftp site:
ndtl.harvard.edu to view RFC 2544 or www.ietf.org.
SmartApplications User Guide
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Chapter 1: SmartApplications Overview
What are SmartCards, SmartModules and MiniModules
What are SmartCards, SmartModules and
MiniModules

SmartCards are custom-designed printed circuit boards (PCBs) that fit within a
SmartBits chassis to generate, capture and track network packet data. They fit into the
SMB-2000 and SMB-200 chassis.

SmartModules are made up of two PCBs within a specially designed tray which fits into
the SMB-6000 chassis. SmartModules provide a higher port density than SmartCards.

MiniModules consist of only one PCB, but have a higher port density than the
SmartCard. They are attached to a tray specially designed for the SMB-600.

The term “card” can refer to any SmartCard or any printed circuit board within a
SmartModule or MiniModule.
SmartApplications User Guide 9
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Chapter 1: SmartApplications Overview
What are SmartCards, SmartModules and MiniModules
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 Basic Test Theory
What’s in this Chapter

This chapter contains the following sections:

Section 1: Starting a Test

Section 2: General Testing Methodology

Section 3: Throughput Test Methodology

Section 4: Latency Test Methodology

Section 5: Packet Loss Rate Test Methodology

Section 6: Back-to-Back Test Methodology
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Starting a Test
Starting a Test
When you have set up the comm port and test parameters and selected the ports to test,
you are ready to start running the test.

To start a test, you can either:

• Click the appropriate launch button on the main SmartApplications window

or

• Select Run from the menu bar.

You can also set all tests to run from the Preferences tab of the Test Setup window. The
next time you open SmartApplications they will begin running automatically.

Note: If you checked the Stop on Error box on the Test Setup window Preferences tab,
the test will stop running when it encounters error conditions such as “Latency packet not
received.” If you want the test to run regardless of errors, leave the box unchecked. If you
plan to run a long test, Netcom Systems recommends that you do NOT check this option.

Stopping a Test

To stop a test while it is running, click the Stop button on the Results window.
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General Testing Methodology
Each SmartApplications test has these features in common:

• Measures device forwarding capabilities

• Requires a pair of SmartBits SmartCards to test frame forwarding: one is the
transmitter, the other is the receiver.

Before testing a device you must:

1 Identify the number of the ports you want to test

2 Ensure that each port to be tested has a unique MAC address

You can chose multiple packet sizes and test durations as specified in the RFC.

SmartApplications logs test results into individual standard ASCII files that you can view
or print with standard utilities.

Test Terminology
The term test refers to the test (such as Throughput or Latency) run for a particular frame
size.

An iteration is when SmartApplications, while maintaining the frame size, varies the
transmission rate based on the last failed rate. The resolution and number of repetitions
determines the accuracy of results.

A trial is one set of iterations for a specific frame size and varying transmission rates.
Tests use trials to determine the optimal rate of traffic for that frame size. It is possible to
have multiple trials for the same frame size. The detailed results displays multiple trial
results. You can specify the number of trials in the Setup Test Configuration window.

The following diagram illustrates these terms:
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Address Learning for SmartCards
SmartApplications assumes that the device under test (DUT) has no knowledge of any
forwarding or routing required. Device forwarding tables are initialized by learning
packets. You can also send learning packets in between every test trial in order to refresh a
device forwarding table before an address is eliminated by aging.

This table lists the contents of learning packets:

Table 2-1. Learning Packet contents

Area Size How Used

Destination 6 MAC address

Source 6 MAC address

Protocol variable Matching user selection of IP, UDP, IPX, or 32 bytes of All
zeros, or All 0xFF's

Test type 12 For Packet Loss and Back-to-Back: 6 bytes of the Netcom
stamp in an ASCII string, and 6 bytes of the destination
address.

For Throughput: a 6 byte incrementing counter with 6 bytes of
destination MAC address.

For Latency: a 6 byte decrementing counter with 6 bytes of
destination MAC address.

Rest of packet n Quantity varies depending on the selected protocol type's fill
pattern.

CRC 4
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Throughput Test Methodology
The Throughput test tests the fastest rate at which a device can forward frames without
error. If a single frame is dropped the test fails and the test is repeated at a lower
throughput rate.

The throughput test satisfies the terminology criteria of RFC 1242 and the test
methodology specified in RFC 2544. From RFC 1242, throughput is “the maximum rate
at which none of the offered frames are dropped by the device.” From RFC 2544, the
methodology to measure throughput is to “Send a specific number of frames at a specific
rate through the DUT and then count the frames that are transmitted by the DUT.”
SmartApplications measures throughput by first sending a series of frames with a
particular source and destination MAC address to the device under test. These frames are
sent from a particular SmartBits port intended to be received by another SmartBits port.

Gap is determined by the initial rate in the test setup. If the initial rate is set to 100%,
frames are sent initially with the gap set to the minimum legal size for the topology and
speed of the transmitting SmartCard. The number of frames sent is determined by the
length of time the test is to run. Frames are validated by counting only frames generated
by the sending port, not any packets sent by the switch. Keep-alive and routing update
frames are not counted as received frames.

If the initial rate is 100%, the first throughput test trial frame rate for a given frame length
is the maximum rate at for the topology and speed of the transmitting SmartCard. If all
frames from the transmitting SmartBits port are received by the receiving port, no further
trials are attempted and the maximum frame rate is recorded as the throughput.

If the first trial fails (if even a single frame is lost), the second trial frame rate drops to
20% lower than the rate at which it failed. The third and each subsequent trial uses a
binary search to determine a rate that is halfway between the last failed rate and the last
successful rate. The test will not finish until the frame loss percent is less than or equal to
the resolution value in the test setup.

Results of the test are automatically logged to a file showing maximum data rate by port
pair and aggregate frame data rate. Percentage achieved of maximum theoretical frame
data rate for each selected frame size is also logged.

This test is performed for a user-specified number of times and the results averaged.
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Latency Test Methodology
Latency Test Methodology
The SmartApplications Latency test measures latency as defined in RFC 1242.

How SmartApplications Calculates Latency

The sending SmartCard sends a burst of frames at a user-specified frame size through the
DUT at a user-specified throughput rate. In the middle of the burst stream it inserts one
frame with an identifying trigger (tag). The time when the trigger frame is fully
transmitted is the Transmit Timestamp. The time the receiving SmartCard recognizes the
trigger frame is the Receive Timestamp. SmartApps calculates Latency as:

(Receive Timestamp) minus (Transmit Timestamp) = Latency

Specifically, SmartApps first measures the cut-through rate and then calculates the store
and forward rate with this calculation:

(Cut Through Rate) minus (Frame Bit Time) = Store and Forward Rate

The Latency test is performed at a user-specified frame rate.

Cut Through (Bit-forwarding) Latency Calculation

For Cut Through device measurements, SmartApps calculates Latency as FIFO (first in-
first out), meaning it calculates the difference between the time that the end of the first bit
of a transmitted frame reaches the DUT's input port (Transmit Timestamp) and the time
that the end of the first bit of the same frame leaves the DUT's output port (Receive
Timestamp).

Store and Forward Device Latency Calculation

For Store and Forward device measurements, SmartApps calculates Latency as LIFO (last
in-first out), meaning it calculates the difference between the time that the end of the last
bit of a transmitted frame reaches the DUT's input port (Transmit Timestamp) and the
time that the end of the first bit of the same frame leaves the DUT's output port (Receive
Timestamp).

Note:
1) It is recommended that you run the Throughput test before you run the Latency test in
order to obtain the optimum throughput rate of the DUT. Then use the throughput rate
obtained from the Throughput test for the Max Rate in the Latency test. Using a proven
optimum rate prevents the tagged frame from being lost due to performance rate issues.

2) SmartApplications always measures Latency and yields results for both store and
forward devices and bit-forwarding (cut-through) devices regardless of the DUT. When
viewing results, use the result that is appropriate for your type of device.
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Packet Loss Rate Test Methodology
This test measures the percentage of frames lost by the DUT that should have been
forwarded.

The Frame Loss Rate test satisfies the terminology criteria of RFC 1242 and the test
methodology specified in RFC 2544. From RFC 1242, Frame Loss Rate is the
“Percentage of frames that should have been forwarded by a network device under steady
state (constant) load that were not forwarded due to a lack of resources”. The test allows
for varying frame sizes from 64 bytes to 1518 bytes for Ethernet ports, and up to 8188 for
Token Ring ports.

From RFC 2544, the methodology to measure frame loss is to “Send a specific number of
frames at a specific rate through the DUT to be tested and count the frames that are
transmitted by the DUT.”

Frames are validated by counting only frames generated by the sending port, not any
packets sent by the switch. Keep-alive and routing update frames are not counted as
received frames.

The Frame Loss Rate test operates in essentially the same manner as the Throughput test.
First a packet burst is performed at the maximum possible rate for a user-specified period
of time. After all packets are sent, the receiving port is queried to determine how many
packets were received. The number of packets not received is determined and the
percentage of loss is calculated.

Note: For Many to 1/1 to Many test configurations between ATM and Ethernet or ATM
and Frame Relay: if the DUT bundles multiple streams into one virtual circuit, SmartApps
counters reflect the number of packets received on a per virtual circuit basis (not per
stream).

This test is performed a user-specified number of times and the results averaged.
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Back-to-Back Test Methodology
Back-to-Back tests the buffering capability of the device under test.

The Back-to-Back test satisfies the terminology criteria of RFC 1242 and the test
methodology specified in RFC 2544. From RFC 1242, the Back-to-Back test is performed
by “fixed length frames presented at a rate such that there is the minimum legal separation
(maximum rate) for a given medium between frames over a sort to medium period of time,
starting from an idle state.” The test allows for varying frame sizes from 64 bytes to 1518
bytes for Ethernet ports, and 8188 for Token Ring ports.

From RFC 2544, the methodology to measure back-to-back frames is to “Send a burst of
frames with minimum inter-frame gaps to the DUT and count the number of frames
forwarded by the DUT.” Frames are validated by counting only frames generated by the
sending port, not any packets sent by the switch. Keep-alive and routing update frames are
not counted as received frames.

The Back-to-Back test operates in essentially the same manner as the Throughput test.
First a packet burst is performed for a user specified period. If all packets are received at
the receiving port, the test is successful and testing is stopped. If even one packet is lost,
the number of packets sent in the burst is halved and retried. If all packets are successfully
received at this point, the packet burst is then chosen half way between the successful and
unsuccessful trials, and retried. This pattern repeats until the actual number of packets that
can be forwarded in a burst is determined.

This test is performed a user-specified number of times and the results are averaged.
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3
What’s in this Chapter

This chapter contains the following sections:

Section 1: Installation

Section 2: Open SmartApplications
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Installation
Installation
It is assumed that you are familiar with Microsoft Windows and basic SmartBits
operation.

System Requirements
To run SmartApplications 2.30, you must have the following:

Hardware

• SMB-2000/200 or SMB-6000/600

• At least two SmartCards

• IBM PC� or 100% compatible

• Pentium 200 or above

• VGA video or better is recommended

• 16 MB of RAM for Windows 95 / 98

• 32 MB of RAM for Windows NT

• 10 MB free hard disk space

Software

• Windows 95�, Windows 98� or Windows NT� 4.0

• SmartBits Firmware 10.10 or higher

• SmartApplications software

Installing from a CD
Please refer to installation instructions on the SmartApplications CD case.

Installing from Windows 95 or Windows NT
SmartApplications is provided on one CD-ROM disk. To install SmartApplications,
perform the following steps:

1 Insert the SmartApplications installation CD in the CD-ROM drive.
The Install Shield window is displayed.

2 Select Install SmartApplications [Ver#].

3 Follow the instructions until all Netcom software is installed.
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Installation
If your PC does not support the automatic install process, you can use the following
alternative procedure.

1 From the Start Menu, select Run.

2 When the Run dialog box appears, type "<cd-rom drive>:\SETUP" in the Command
Line, then click the OK button.

3 Follow instructions as the installation program installs the software.
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Open SmartApplications
Open SmartApplications
From the Start menu, select Programs > SmartApplications. The SmartApplications
main window is displayed.

Close SmartApplications

To close SmartApplications, click the Close button at the top right corner of the screen.
or

Select File > Exit from the menu bar.
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4
What’s in this Chapter

This chapter contains the following sections:

Section 1: The Main Window

Section 2: Charting Test Results
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The Main Window
The Main Window
The SmartApplications main window is a dynamic window that changes according to the
selections you make, such as selecting 1 to Many or 1 to 1 testing.

Parts of the Main Window

Menu Bar

Tool Bar

Connection

Test Launch
buttons

Port Selection
area

Card Attributes
area

status
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Menus

File Menu

The File Menu contains the following options:

• New
Opens the default SmartApplications test configuration (.sig) file. If you changed the
default values, this option allows you to reset the values to the defaults.

• Open
Opens a previously saved SmartApplications test configuration (.sig) file.

• Save
Saves the current settings as a .sig file.

• Save As
Saves the current test configuration under a new name.

• View Results File
Opens the Results window. Once the Results window opens you can view results for
the current configuration or for saved results for any previous configuration.

• Print
Prints the current configuration file.

• Print Setup
Allows the user to select the printer and setup printer options.

• Exit
Terminates the SmartApplications program.

Actions Menu

These menu options allow you to connect or disconnect to the SmartBits chassis.

• Connect
Establishes the logical connection from your PC to the SmartBits chassis.

• Disconnect
Breaks the logical connection from your PC to the SmartBits chassis.

Note: You must first disconnect from the SmartBits chassis in order to access the
Connection setup.

Setup Menu

All of the Setup menu options except All SmartCards are active only when you are
disconnected from the SmartBits chassis. The Setup menu contains the following options:
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• Test Configuration
Accesses the Setup Test Configuration window where you specify test parameters
such as the duration, learning packet information, and global test preferences.

• All SmartCards
Accesses the Setup All SmartCards window where you can specify setup information
for all SmartCards from one window instead of by individual card attribute tab, and
make test-by-test or global changes to all cards, such as the speed. You can also
access the Network IPs window and Token Ring Properties window from this
window.

• ATM Traffic Descriptor Type
Accesses the Traffic Configuration window where you specify call setup broadband
capabilities, and forward and backward traffic descriptor specifications.

• SmartBits Connections
Accesses the Setup SmartBits Connections window where you select a Serial (Com)
port or an IP address connection.

• SmartCards Reservation
Enables you to change the Reserved or Available status of slots when multiple users
are running tests on the same chassis.

Run Menu

The Run menu allows you to select one test to start running or to start all tests running in
succession. You can also use the test launch buttons on the main window to start a test.
The menu contains these options:

• Throughput
The Throughput test tests the fastest rate at which a device can forward frames
without error. If a single frame is dropped the test fails and the test is repeated at a
lower throughput rate. You can perform bi-directional Throughput testing in half-
duplex mode.

• Latency
The time the receiving SmartCard recognizes the trigger frame is the Receive
Timestamp. SmartApps calculates Latency as: (Receive Timestamp) minus (Transmit
Timestamp) = Latency

• Packet Loss
This test measures the percentage of frames lost by the DUT that should have been
forwarded.

• Back to Back
Back to Back tests the buffering capability of the device under test.

• All
Performs all four tests.
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The Main Window
Help Menu

This menu contains two options:

• Contents
Accesses SmartApplications online Help.

• About SmartApplications
Displays the current application version number, firmware number, SmartBits
Programming Library number used, and the serial number of the SmartBits controller.
From the About window you can also access the Card Information window, which
automatically displays information about SmartCards such as firmware version infor-
mation.

Launch Buttons

Click one of these buttons to start running a test:

• Throughput

• Latency

• Packet Loss

• Back-to-back

You can also start these tests from the Run option in the menu bar or select All from the
Run menu to select all of the tests.
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The Main Window
Toolbar Buttons

Table 4-1 Toolbar Buttons

Opens an existing configuration file.

Saves the current configuration to a file.

Prints the current configuration file.

Connects SmartApplications to the SmartBits chassis. This allows you to display
the card attributes for the SmartCards in the chassis.

Disconnects SmartApplications from the SmartBits chassis. In order to set up the
Ethernet or serial port in SmartApplications, you must first disconnect from the
chassis.

Displays the Setup SmartBits Connections window from which you select a serial
(Com) port or an IP connection.

Displays the SmartCard Status window from which you check the status of,
reserve, or release SmartCard ports in multi-user configurations.

Displays the Setup Test Configuration window where you can specify test
configurations and preferences.

Displays the Set Up All SmartCards window where you can configure the
attributes for all or multiple ports from a single window.
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Accesses the About SmartApplications window, which displays the current
application version number, firmware number, SmartBits Programming Library
number used, and the serial number of the SmartBits controller.

From the About window you can also access the Card Information window,
which automatically displays information about SmartCards such as firmware
version information.

Table 4-1 Toolbar Buttons
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The Main Window
Port Selection Area
This part of the window is where you specify the SmartCard ports that you want to include
in a test. Checking the Bi-directional box causes the selected port pairs to transmit
simultaneously in both directions as in full duplex operation. Checking Reverse Tx & Rx
port reverses the transmission direction.

You also select the type of tests you plan to run: 1 to 1 or 1 to M from this part of the
window.

Selecting Ports for 1-to-1 Tests
1 Click the 1 to 1 box. The main window displays the following 1 to 1 port selection area:

2 Select at least one pair of Source and Destination ports.

3 Click the Bi-directional box if you want the selected port pair(s) to transmit and
receive simultaneously.
or
Click the Reverse Tx & Rx port box to reverse the direction of the transmission.
SmartApplications User Guide



Chapter 4: Basic Navigation and Tools
The Main Window
Selecting Ports for 1 to Many Tests
1 Click the 1 to M box. The main window displays the following 1 to M port selection area:

Note: 1 to Many and Many to 1 tests are not compliant with RFC 2544.

2 Select the direction for the test using one of the direction buttons. The Source and
Destination fields will change locations depending on the direction you select.
Note: If you change the direction, the Destination MAC and SmartCard MAC
addresses on the card attributes tab remain unchanged. Ensure that you enter the
correct destination MAC address for the DUT.

3 Select a Source card(s) and Destination card(s).
The last card that you select in the Source (Many to 1), or Destination (1 to Many) or
Available Ports field will be the card whose attributes appear as the second tab, as
illustrated in this Destination Index example:

Connection Status

In the bottom right-hand corner of the main window, a green light with the word
“Connected” displays when you are connected to SmartBits. The light is grayed out and
the word “Disconnected” displays when you are not connected.
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Charting Test Results
Once a test has finished running, you can present the results of the test in graph form. You
can create a wide variety of charts to graphically represent test results by using the Chart
Wizard. Charts range from 2D or 3D pie and bar charts to Gantt charts. You can also
customize titles, layouts, legends, and axes. The Chart Wizard is a separate charting
facility provided with SmartApplications.

To create a chart from the appropriate Results window tab do these steps:

1 Select the rows and columns you want to appear on the chart. To do this, click on the
first cell and then hold down the Shift key and click on the last cell to include. The
block of cells will be highlighted.

2 Click the Create Chart button to display the Chart Wizard.
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3 Select the type of chart you want to create from the Chart Wizard. The chart will be
attached to the spreadsheet.

4 Double click on the outside of the chart to access the Format Chart window and cus-
tomize the format.
For more information about how to use the Chart Wizard, refer to the Chart Wizard's
online help user guide. To access the online Help click the Help button from the Chart
Wizard window. The online Help system is called First Impression.
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5
This chapter contains the following sections:

Section 1: Summary of Steps to Set Up a Test

Section 2: Connecting the Device Under Test

Section 3: Modifying the SmartBits Connection Setup

Section 4: Setting Up Test Configurations

Section 5: Selecting Test Ports

Section 6: Configuring Test Ports

Section 7: Router Testing
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Summary of Steps to Set Up a Test
Summary of Steps to Set Up a Test
Connect the device under test to your SmartBits chassis. Refer to the next section for more
information.

1 If you are running SmartApplications for the first time, set up the communications
port between your PC and the SmartBits chassis at the Setup SmartBits Connections
window.

2 Set up the test configuration and preferences from the Setup Test Configuration win-
dow or open a previously saved configuration file that you want to use for the tests.

3 Select the ports for the test(s) and the traffic direction from the SmartApplications
main window.

4 Configure the ports, such as assign the MAC address for the card, from the main win-
dow. If you are using an ATM card, you must also set up line and ELAN parameters.

Note: If you are testing a router, you must check the Router Test box at the Test Setup
window Preference tab.

Connecting the Device Under Test
For simplicity, connect Port 1 on SmartBits to Port 1 on the device under test, Port 2 to
Port 2 and so on (if possible).

Verify that the cable is correctly connected by checking that the device's link light is on.

For more information about setting up the hardware and your SmartBits chassis refer to
the Getting Started manual or the SmartBits System Overview and Reference manual.
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Modifying the SmartBits Connection Setup
The SmartBits Connections setup defines to SmartApplications the communications port
that your PC is using to connect to SmartBits. SmartApplications uses the serial port
COM2 as the default, which runs at 9600 baud.

If you have a SmartBits SMB-2000, SMB-200, SMB-6000, or SMB-600 chassis, you can
connect your PC to either the serial or the Ethernet port on the SmartBits chassis. Connect
to the Ethernet port if you want to:

• Control the SMB-2000, SMB-200, SMB-6000, or SMB-600 chassis over a local
network

• Retrieve data and execute tests faster

Summary of Steps to Modify Comm Port Setup
1 Disconnect from SmartBits by selecting Actions > Disconnect from the menu bar.

2 Select Setup > SmartBits Connection. The Setup SmartBits Connections window is
displayed.

3 Define the port using the appropriate tab, and check or uncheck the Serial checkbox.
If you use the Ethernet port, check the box beside the port in the Connection List field
to activate the one you want.

4 Reconnect to SmartBits by selecting Actions > Connect from the menu bar.
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Connecting to the Serial Port
If you want to connect your PC to SmartBits using the serial port, check Serial on the
Setup SmartBits Connections window:

Serial Port Tab

This table lists and describes the Serial Port tab fields.

Table 5-1 Serial Port tab fields.

Field Description

Available Comm
Port

Lists all available serial communication ports from which you can
select. Select the ports from this list and click the > button.

Selected Comm Port Lists the ports to which you want to connect. COM2 is the default.

Speed Select a baud rate. The default is 9600.

Note: Make sure to check the Serial checkbox. If you do not
check this box, the following can happen:

• If you have an SMB-2000 or -200 the Ethernet port will be
used instead.
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Connecting to the Ethernet Port
If you want to connect your PC to SmartBits using the Ethernet port, use the Ethernet/
TCP (SMB-2000, SMB-200, SMB-6000, or SMB-600 chassis only) tab of the Setup
SmartBits Connections window. You can define up to eight Ethernet ports.

To access the Comm Port Setup window

Select Setup > SmartBits Connections from the menu bar.

To activate or deactivate a port

In the Connection List field, check the box beside the port to activate it, or uncheck to
deactivate it.

Note: Be sure to uncheck the Serial checkbox in the Setup SmartBits Connections
window. If you do not uncheck this box, the serial port will be used instead.

Ethernet/TCP Port Tab

This table lists and describes the Ethernet/TCP Port tab fields.

Table 5-2 Ethernet/TCP Port tab fields.

Field Description

SmartBits IP Addr The IP address of the SMB-2000/200 or SMB-6000/600.

TCP Port The port on which the connection will be made. This is the listener
port of the SMB-2000/200 or SMB-6000/600. Netcom Systems
assigns this number (16385) to the SmartBits chassis.
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Linking Multiple SmartBits Chassis
You can connect multiple controlling SmartBits chassis by assigning each controlling
chassis an IP address, as shown in the following graphic:

Figure 5-1. Numbering Stacked and Daisy-chained chassis

Rules for Selecting Hub/Slot/Port Configurations

To understand hub/slot/port designations in SmartApplications, keep the following rules
in mind:

• You can link a maximum of eight chassis across, each with a unique IP address.

• You can stack SMB-2000 chassis in arrangements of up to four individual chassis.

The top hub in the stack must be an SMB-2000. The bottom three chassis may be
either SMB-2000s or SMB-10s.

Note: You cannot stack SMB-6000s, SMB-600s, or SMB-200s chassis.

• When you link SmartBits chassis, four (real or virtual) hubs are allocated to each IP
address (for each chassis linked across). Space is reserved for these hubs whether or
not actual physical chassis are installed.

• The number of ports per slot depends on the type of card installed in the slot. The
maximum configuration for a SmartBits chassis stack is 96 ports. This results in a
maximum port capacity of 768 ports per SmartBits chain (eight SMB-6000, each
populated with 96 ports).
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• Hub/slot/port information appears in port selection and in test reports. Information
displays in the format [xx,xx,xx]. For example, [05,04,03] represents hub 5, slot 4,
port 3.

• The arrangement of hub/slot/port information in the connection list is based on the
order in which IP addresses are arranged on the list. For example, with the chassis
illustrated above, the IP address for Hub 13 (192.106.1.13) is listed fourth in the
connection list. If this IP address had been listed first, Hub 13 would now be Hub 1.
The IP address listed next would then become Hub 5, and so on.

Synchronizing Clocks in Remote Chassis

To synchronize the clocks in multiple controllers that are remote from each other and start
and stop tests simultaneously among those SmartBits chassis, use a GPS (Global
Positioning System). The GPS becomes the clock source for each chassis by providing
each SmartBits with an atomic clock. A 10 MHz frequency signal replaces the SmartBits
backplane clock and guarantees very precise latency measurements.

SmartApplications automatically recognizes GPS and will synchronize the start of traffic
between chassis. Netcom Systems currently supports the Hewlett Packard� HP58503B
GPS Time and Frequency Reference Receiver.

Note: Prior to running a latency test between two remote SmartBits chassis in GPS mode,
endure that the GPS receiver has been on for several hours. This is necessary for the GPS
receiver components to be locked on. If you fail to do this, error messages may occur
within SmartApplications.

For more information about how to set up the GPS receiver and cable information, refer to
the Using GPS with SmartBits Application Note #15 that accompanies your GPS unit.

Multi-User Access

SmartBits chassis currently supports up to 10 simultaneous users. When online,
SmartApplications displays the cards and their current status, which can be Reserved or
Available.

Multi-user capability requires a SmartBits chassis with version 6.50 firmware or higher.
SMB-2000 chassis must display a multi-user ready sticker.

Note: You can not use any card until you have reserved it.

Multi-Users on the SMB-2000

A multi-user ready SMB-2000 has an identifying sticker on it. Unlike the SMB-6000
chassis which is multi-user ready, any SMB-2000 chassis without a sticker must be
refitted at the Netcom factory to be multi-user compliant. At the factory, the following
modifications are made:

• A SMB-2000 multi-user compliant backplane is installed.
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• Chassis firmware 6.50 or later is installed.

The SMB-200 is a single-user only chassis.

When these modifications are present on an SMB-2000, SmartWindow displays the multi-
user interface. Otherwise, connected to an SMB-2000 without the above modifications,
SmartWindow displays the single-user interface.

Reserving SmartCards
In multi-user configurations, you must reserve SmartCards before you can use them for
running tests. To use SmartCards in multi-user configurations, you first check the status of
the SmartCards in chassis you are using for the test, then reserve available SmartCards for
your use. In the same manner, you release SmartCards you no longer need.

Checking SmartCard Status

To check the status of SmartCards in your multi-user configuration, do one of the
following:

1 Click the Reserve/Release SmartCards toolbar button on the SmartApplications
main window
or
Select Setup > SmartCard Reservation.
The SmartCard Status window displays:

2 Click the tab for the controller (chassis) you wish to view.
SmartApplications User Guide



Chapter 5: Set Up Tests
Modifying the SmartBits Connection Setup
The controller tab displays the hub, slot, and number of each port, the SmartCard
model number, and the status of the port: Reserved or Available. In the Hub column, a
blue light indicates Reserved status and a green light indicates Available status.

Reserving SmartCards

To reserve an available SmartCard from a tab in the SmartCard Status window, follow
these steps:

1 Click on the port you wish to reserve to highlight it.

2 Click Reserve.
SmartApplications automatically updates the controller field to show your selection.
You can also click Refresh to update the field.

3 Click Close when you are finished reserving SmartCards.

Releasing SmartCards

To release a SmartCard you have reserved, follow these steps:

1 From a tab in the SmartCard Status window, click on the port you wish to release to
highlight it.

2 Click Release.
SmartApplications automatically updates the controller field to show your selection.
You can also click Refresh to update the field.

3 Click Close when you are finished reserving SmartCards.
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Setting Up Test Configurations
SmartApplications allows you to specify test parameters that you can save to a file for
future use. For example, for each test you can specify how long you want the test to run
and the range of packet sizes to be sent. You can also select all tests by selecting Run >
All.

From the Test Setup window you can select test parameters such as the test duration, how
many iterations are to be performed, and what packet sizes are to be tested. To access the
Test Setup window, select Setup > Test Configuration from the menu bar.

The Test Setup window contains two tabs:

• Test Configuration

• Preference

Test Configuration Tab

Use the Test Configuration tab to set options for all tests and for each individual test.
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General Area options

These options on the Test Configuration tab enable you to specify the range of packet
sizes to transmit during the test. Tests do not necessarily run until the maximum (Stop At)
packet size is sent. For example, if the Start From field is set to 64, the Stop At field is
set to 200, and the Step Size is 64, the test will send packet sizes of 64, 128, and 192. It
will not continue to send the 256-byte packet since the Stop At field specifies 200.

Note: If the value in the Step Size field increments the current packet size to a number
larger than that in the Stop At field, the test will stop.

• Start From
Enter or select the size of the smallest packet to send. The default size is 64 bytes.

• Stop At
Enter or select the size of the largest packet to send. The default size is 1518 bytes.

• Step Size
Enter or select the number of bytes that the current packet size will be incremented
with each test.
For example if the step size is 10 bytes, the first test transmits packets that are 64
bytes, and the next test transmits packets that are 74 bytes.

• Use Custom

• Unchecked: Runs tests with the settings in the Test Configuration tab.
Default custom sizes are: 64, 128, 256, 512, 1024, 1280 and 1518.

• Checked: Runs tests according to the packet sizes specified at the Custom Packet
Sizes window. Enables the Sizes button.

Learning Packets options

Learning packets inform the test device's forwarding tables of the MAC addresses for
sending and receiving SmartCards. You can send learning packets in between every test
trial to refresh a device forwarding table before an address is eliminated by aging.

• Learning Mode
Select the mode by which SmartApplications sends out learning packets to update the
device's forwarding tables. Possible modes:

• Never
SmartApplications never sends learning packets to the device under test.

• Once
Sends learning packets once at the beginning of each test. For example, if you
select packet sizes of 64 and 128 bytes, SmartApplications sends learning packets
before the 64-byte test and again before the 128-byte packet test.

• Every Trial
Sends learning packets before each trial. For example, if you were testing at a
packet size of 64 bytes, starting at 50% and incrementing 10% each time, learning
packets would be sent before the 50% trial, before the 60% trial and so on.
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• Learning Retries
Enter or select the number of times SmartApplications should retry sending learning
packets before it starts the actual test. Some devices require more packets to learn an
address. This value is used to loop on the transmission of the learning packets. There
is a 1 second delay between retries.

Note: If your device shows signs of flooding during testing, you might need to use more
than the Learning Packets default of Once per test and the Learning Retries of 3 retries, or
increase the aging timer in the DUT.

Individual Test options

You must run the Throughput test before you run the Latency test. Use the throughput rate
obtained from the Throughput test for the Latency test. Using a proven optimum rate
prevents the tagged frame from being lost due to rate (gap size) issues. Fill out a tab for
each test that you want to run.

• Duration (sec)
Enter or select the length in seconds for which you want to run each trial of the test. It
is the amount of time that SmartBits will send data for each packet for the selected
test. Possible values range from 1 to 999 seconds.

Note: For 100 Mbps SmartCards, do not use a value greater than 110 seconds or you
will get the error message “Parameter out of range.” when you run the test

• Number of Trials
Enter or select the number of times that you want SmartApplications to repeat the
selected test(s) (for example, Packet Loss, Throughput). Values range from 1 to 25 for
each packet length. After the test SmartApplications averages the results before
reporting a summary of all trials for each test.

• Initial Rate (%)
The rate at which packets will be transmitted at the start of a trial.

• Step Rate (%)
This field does not apply to the Throughput test.
The percentage that the test increments with each trial. Step rate specifies how quickly
the test rate will increase after a trial finishes. Select a number or enter an integer or
decimal value. The minimum decimal value you can enter is .1.

• Min. Rate (%)
The rate at which transmission trials will stop. Select a number or enter an integer or
decimal value. The minimum decimal value you can enter is .1.
This field does not apply to Latency tests.

• Max. Rate (%)
The maximum rate at which each packet size should be transmitted. Select a number
or enter an integer or decimal value. The minimum decimal value you can enter is .1.
When selecting this rate for the Latency test, the Latency measurement should be at
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the rate where the Throughput test passed. Setting a value of 100% may not be
measuring the true latency of your device under test. Set this value accordingly.
For example, if you know a particular device cannot exceed 90% of wire speed, you
could set the maximum to 90% to save time.

Note: It is recommended that you run the Throughput test before you run the Latency
test in order to obtain the maximum throughput rate of the DUT. Then use the
throughput rate obtained from the Throughput test for the Max Rate in the Latency
test. Using a proven rate prevents the tagged frame from being lost due to rate (gap
size) issues.

• Resolution (%)
This field applies only to the Throughput test. Resolution determines how exact the
test result is. Lower settings yield a more precise result but usually results in longer
test times.

Example of How Test Configuration Settings Work

If you set the resolution to 2%, the testing will stop when the difference between the last
successful test and the last unsuccessful test is less than 2%. If the initial trial failed at
100%, the second trial might run at 50%. Assuming no packets were dropped at 50%, the
next trial would increase to 75%. Again assuming no lost packets, the rate of the next trial
might increase to 87.5% and so on. Eventually, you might run a trial at 98.2%. Since the
resolution was set to 2% the testing would stop here since 100 - 98.2 is 1.8% which is less
than 2%. If the resolution had been set to 1% another trial would be run, since 1.8% is
greater than 1%.
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Customizing Test Packets

The Use Custom option on the Test Configuration tab allows you to set your own test
packet sizes. Click the Sizes button on the Custom Packet Sizes window to access the
Custom Packet Sizes window:

The default values are the seven packet sizes specified for Ethernet testing in Section 9.1
of RFC 1242. To change the number of Packet Size fields, enter or select a new value in
the Number of Sizes box. The maximum number of packet sizes is 25. To enter a custom
value for a packet size, click on a Packet Size field and type in a value.

Click the OK button to close the window and make the selected changes the current
settings. Click Cancel to close the window without making changes. Click Default to
revert to the seven default packet sizes.
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Preference Tab
Use the Preference tab of the Test Setup window to specify report filenames and other test
options. To access this window, select Setup > Test Configuration from the menu bar
and click the Preferences tab:

Preference Tab Fields

This table lists and describes the Preference tab fields:

Table 5-3 Preference tab fields.

Field Description

Start Throughput Check to automatically start this test when you start
SmartApplications.

Start Latency Check to automatically start this test when you start
SmartApplications.

Start Packet Loss Check to automatically start this test when you start
SmartApplications.
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Start Back to Back Check to automatically start this test when you start
SmartApplications.

Create Tabular
Report

Check to generate reports in tabular format with results by
packet size running horizontally across the page. Uncheck the
box if you want to use the non-tabular format.

Connect to SmartBits
at Startup

Check to automatically connect to the SmartBits chassis when
SmartApplications starts. This speeds up application startup
time.

Router Test Check this box if you are testing a router. Checking this box
enables the Next Hop Test checkbox.

Stop On Error Checked: When errors are encountered the test stops running
and error message boxes are displayed so that you can correct
the condition. For example, for ATM cards, you might see the
message:

ILMI is not established.

Unchecked: Any errors are ignored and the test continues.
Errors messages are logged to the results file. Leave this box
unchecked if you want the test to run regardless of error
conditions such as “Latency packet not received.”

Note: If you check the Stop on Error box on the Test Setup
window Preferences tab, the test will stop running when it
encounters error conditions such as “Latency packet not
received.” If you want the test to run regardless of errors, leave
the box unchecked. If you plan to run a long test, Netcom
Systems recommends that you do NOT check this option.

Next Hop Test Enables you to test the Next Hop gateway address.

Disable ET Display Checked: the SmartBits controller does not try to track updates
for the front panel of an attached ET-1000.

Unchecked: Uncheck this box only if your test bay has an ET-
1000 controller, and you want to track some particular ET-1000
counters through the front panel display.

Tear down ATM
connection every
frame size test

Disconnect the stream and connection for each trial when testing
ATM cards.

VPI-VCI Hex Format Check to view VPI and VCI values in hex format.

Table 5-3 Preference tab fields.

Field Description
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Saving a Test Configuration
You can save the test settings you specify for ports and tests by saving it to a configuration
(.sig) file. Using .sig files saves a lot of time in protocol header editing and is highly
recommended.

To save to a file

Select File > Save As and enter the name of the file.

The last saved configuration becomes the default configuration for any future tests.

To load the configuration file at a later time

Select File > Open and select the file.

Keep Frame Relay
PVC Active between
Trials

Check to prevent the teardown of the PVC between trials, i.e.,
between going from one packet size to the next or from one
frame rate to the next.

Delay After Transmit Select the number of seconds to wait after all Tx cards have
finished transmitting.

SmartCard
Reservation Options

Select the option for reserving or releasing SmartCards in multi-
user environments. You can elect to reserve one to all
SmartCards for yourself throughout the session. You may also
elect to reserve no SmartCards for yourself when you connect to
a chassis.

You can specify a SmartCards reservation timeout in the
Minutes field. If you select this option, the timer starts every
time you connect. If the timeout you specify occurs, all of the
unselected SmartCards in the multi-user chassis are released.

Table 5-3 Preference tab fields.

Field Description
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Selecting Test Ports
You must select at least two ports: one to send (Source) and one to receive (Destination)
the test traffic generated when you run a test. Source ports generate traffic to the device
under test (DUT). Destination ports receive and check the data received from the DUT. If
you have four SmartBits chassis each filled with 20 SmartCards on an SMB-2000, for
example, you can have up to 80 ports.

The category of test determines what configuration you use the for a test:

• 1 to 1 Tests use one or more ports pairs only.

• 1 to Many/Many to 1 Tests use more than two ports for destination or source,
respectively.

For either category, use the > button to add a port(s) to a field. Use the < button to remove
a port(s) from a field. Use the >> or << button to add or remove all ports from a list.

Identifying Hubs, Slots, and Ports
To identify a port in a SmartBits chassis, you specify three values:

Hub # The SmartBits chassis that contains the SmartCard or module

Slot # The slot where the card or module is inserted

Port # The port on the card or module

These are referred to collectively as the Hub/Slot/Port triple. For all three values,
numbering starts at 1.

Note: Slot numbers increment sequentially whether ports are physically installed or not.

Port Numbering

SMB-2000/200

The SmartBits 200 (SMB-200) is a four-port chassis with four vertical SmartCard slots.
The SmartBits 2000 (SMB-2000) is a 20-port chassis with 20 vertical SmartCard slots.

Refer to “Linking Multiple SmartBits Chassis” on page 40 for additional information.

SMB-6000/600

The SmartBits 600 (SMB-600) is a 2- to 16-port chassis with two MiniModule slots. The
SmartBits 6000 (SMB-6000) is a 12- to 96-port chassis with six multi-port SmartModule
slots arranged horizontally in trays.

On the SMB-600/6000, SmartModules are numbered one through six from top to bottom.
See the numbers located on both sides of the interface. Each SmartModule is made up of
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two cards designated A and B. The A card is located in the left side of the chassis and the
B card is on the right. Each port is numbered from left to right.

Refer to “Linking Multiple SmartBits Chassis” on page 40 for additional information.

For example, in the designation “LAN 6100A SMB-6000 2A2”, LAN 6100A is the
SmartModule type, SMB-6000 is the SmartBits type, 2 is the SmartModule number or slot
within the chassis, B is the card within the SmartModule, and 2 is the port number on the
SmartModule.

Allowable Port Pair Combinations
SmartApplications allows you to test various mixed or same topologies. Select a type of
test for which you want to see allowable SmartCard port pair combinations:
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One to One Test Port Pair Combinations Allowed

SmartApplications supports all models of SmartCards currently available. All 4 tests are
supported with exceptions listed below.

Table 5-4 Allowable One to One port pair combinations

TO: Ethernet Token Ring ATM Frame
Relay

FROM:

Ethernet Y Y*

* Router testing only.

Y†

† Supports LANE 1.0 SVCs and Classical IP PVCs only.

Y‡

‡ Frame Relay cards only support one DLCI. Only one connection between
topologies is supported.

Token Ring Y**

** Router testing only.

Y N Y

ATM Y††

†† ATM to Ethernet supports Packet Loss tests using LANE SVCs and Classi-
cal IP PVCs only.

N Y‡‡

‡‡ ATM to ATM supports Throughput and Packet Loss tests for PVC Classical
IP only. Router or ATM switch testing.

Y***

*** Router testing only. ATM to Frame Relay supports Throughput and Packet
Loss for PVC Classical IP only.

Frame
Relay

Y†††

††† Frame Relay cards only support one DLCI. Only one connection between
topologies is supported.

Y Y‡‡‡

‡‡‡Router testing only. Frame Relay to ATM supports all tests for PVC Classi-
cal IP only. Frame Relay supports only one DLCI.

Y****

**** Frame Relay cards only support one DLCI. Only one connection between
topologies is supported.
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1 to Many/Many to 1 Test Allowable Port Combinations

SmartApplications supports all models of SmartCards currently available. Only Packet
Loss and Back-to-back tests are supported.

For configurations between ATM and Ethernet or ATM and Frame Relay: if the DUT
bundles multiple streams into one virtual circuit, SmartApplications counters reflect the
number of packets received on a per virtual circuit basis (not per stream).

Exceptions are listed in this table:.

Table 5-5 Allowable 1 to Many and Many to 1 port combinations

TO: Ethernet Token
Ring

ATM Frame
Relay

FROM:

Ethernet Y Y*

* Router testing only.

Y†

† Ethernet to ATM supports LANE 1.0 SVCs and Classical IP PVCs only.

Y‡

‡ Frame Relay only supports one DLCI. Only one connection between
topologies is supported.

Token Ring Y**

** Router testing only.

Y N Y

ATM Y††

†† ATM to Ethernet only supports Packet Loss and Throughput tests.

N Y‡‡

‡‡ ATM to ATM only supports Packet Loss test for PVC CLIP.

Y***

***Router testing only. ATM to FR via PVC CLIP only.

Frame
Relay

N†††

†††Requires FR card to support multiple DLCIs. Currently, only one DLCI
is supported.

N‡‡‡

‡‡‡Requires FR card to support multiple DLCIs. Currently, only one DLCI
is supported.

N****

****Requires FR card to support multiple DLCIs. Currently, only one DLCI
is supported.

N††††

††††Requires FR card to support multiple DLCIs. Currently, only one DLCI
is supported.
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Running 1 to 1 Tests
This category sends traffic from one port to another port. The Source and Destination
fields display ports for each of the cards in your SmartBits chassis. Checking the
Bi-directional box causes the selected port pairs to transmit simultaneously in both
directions as in full duplex operation.

1 Click the 1 to 1 radio button.

2 Select a port number from the Source list box and from the Destination list box. With
both ports highlighted, click the > button to add the pair to the Test Pairs list box.

3 Check the Bi-directional box if you want both cards to transmit.

Note: When you run bi-directional Latency tests, SmartApplications determines results
for only one direction. For example, if you select source Port 1 and destination Port 3, the
results would reflect the Port 1 to Port 3 direction only.
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Bi-directional Traffic

Checking the Bi-directional box causes the selected port pairs to transmit simultaneously
in both directions for full duplex implementations. This option is only available for 1 to 1
Tests.

Netcom Systems does not recommend using bi-directional testing when the link speeds
and/or topology of the transmitting and receiving SmartCards differ. For example, if you
test a router with an Ethernet and ATM port pair, the bi-directional results would not be
meaningful, because the percentage of traffic offered on each side would not be equal.

Note:
1) Performing bi-directional throughput tests in half-duplex mode at high rates will result
in line collisions. Excessive collisions will effectively increase the total transmission time
which may render the test results invalid. When this occurs, throughput is calculated based
on the intended load as opposed to the actual offered load.

2) When you run bi-directional Latency tests, SmartApplications determines results for
only one direction. For example, if you select source Port 1 and destination Port 3, the
results would reflect the Port 1 to Port 3 direction only.
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Running 1 to Many/Many to 1 Tests
This category sends traffic from one port to many ports or from many ports to one port.

Note: In the 1 to Many mode only Packet Loss and Back-to-back tests are available.

To run a 1 to Many or Many to 1 test

1 Click the 1 to M radio button.

2 Click the direction button to specify the test should run from 1 port to many ports or
many ports to one. You can do this step at any time.

3 Select a port(s) from the Available Ports list box. and click the < button. The port(s)
appear in the Source or Destination box, depending on the direction you select. The
Destination box is shown in the graphic above.

On startup, SmartApplications queries SmartBits to see how many SmartCards exist in the
connected chassis and displays them in the Available Ports box by default.

Note:
1) If you change the direction, the Destination MAC and SmartCard MAC addresses on
the card attributes tab remain unchanged. Ensure that you enter the correct destination
MAC address for the DUT.

2) For configurations between ATM and Ethernet or ATM and Frame Relay: if the DUT
bundles multiple streams into one virtual circuit, SmartApplications counters reflect the
number of packets received on a per virtual circuit basis (not per stream).
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Configuring Test Ports
Once you define the communications port between your PC and the SmartBits chassis,
you can configure the SmartBits ports you want to use in the tests.

You can set up test ports in either of these ways:

• All or multiple ports at once from one window (Setup All SmartCards).
This is a convenient and faster method if you have many ports because it allows
global attribute changes.

• A pair of ports at a time using individual card attribute tab pairs at the main window.

SmartApplications stores the last four setup configuration (.sig) files that were used in a
SMARTAPP.INI file in your Windows directory. Every time you open
SmartApplications, the last configuration file is recalled.
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Configuring All or Multiple Ports at Once
You can configure the attributes for all or multiple ports from a single window called the
Setup All SmartCards window instead of setting each port's attributes individually. To
access this window, select Setup > All SmartCards from the SmartApplications main
window:

Note: Highlighted fields are not modifiable.

Changing Individual Cell Values in the Setup All SmartCards
Window

The way to modify a cell on the Setup All SmartCards window depends on the attribute
(field).

To Modify Speed, Duplex, and Protocol Fields

1 Click on a cell to highlight it.

2 Right click on the cell to display the popup menu and select a value.
Example: You right click on an SX-7410 card's Speed field currently set to 100M.
Since this card is capable of two speeds (10 or 100 Mbps), the popup menu displays
two options: Low and High. If you select High, the value stays the same. If you select
Low, the value changes to 10M. SmartApplications automatically enters the correct
specific values for the SmartCard.
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To Modify Destination MAC and IP/IPX fields

To Modify Destination MAC, SmartCard's MAC, and SmartCard's IP/IPX, Router's IP/
IPX Fields, click on a cell and enter the new value.

For *Net IPs/+Ring Field

1 Click on a cell to highlight it.

2 Right click on the cell to display the popup menu. If Network IPs or Token Ring does
not apply to the port, the option is greyed out on the popup menu. Select a value.

• If * appears in the field, you can access the Network IPs window from the popup
menu to modify the Network IPs for Next Hop tests.

• If + appears in the field, you can access the Token Ring Properties window for Token
Ring networks. If */+ appears, you can access either window.

Changing Values by Column in the Setup All SmartCards Window

You can change a field for all ports at once by changing the appropriate column. For
example, you can change the Protocol column for all cards.

Note: You must specify MAC and IP fields individually by port.

To change all the fields in a column

1 Click the column header to highlight the entire column.

2 Right-click the header. A popup appears with the options available for that column.

3 Select an option from the popup. All modifiable cells will be changed to the option
you selected.
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Configuring a Pair of Ports at a Time
1 Select the ports for the test from the SmartApplications main window, if not yet done.

2 Expand the SmartApplications main window to view the card attribute tabs. Two tabs
display for the source and destination ports that you last selected. Ensure that these are
the ports with which you want to run tests.

3 Define the MAC addresses for source and destination ports. For routers this is the
MAC address of the local router port. If you are doing 1 to Many/Many to 1 tests, then
you must define addresses for each card included in the test.

4 Define any other information relevant to the selected port type, such as

• Next hop network IPs for Next Hop tests

• Token Ring properties for Token Ring cards

• Line and ELAN parameters for ATM cards

• Line or LMP or Address information for WAN cards

Each card attribute tab displays different fields, depending on the type of port (Ethernet,
Token Ring, ATM or Frame Relay/WAN) you selected.
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Configuring Ethernet Ports
When you select an Ethernet port, the appropriate Ethernet card attribute tab is displayed.
Some of the fields are specific to Ethernet.

Note: For Ethernet cards, SmartApplications sends out Ethernet 802.3 test frames.

Ethernet Card Attribute Tab

This table lists and describes the Ethernet card attribute tab fields:

Table 5-6 Ethernet card attributes fields.

Field Description

Card Type Displays the type of Ethernet SmartCard for that port, such as Fast
Card for 100 Mbps.

Card Model Displays the model number of the card, such as SX-7410.

Signal Rate The transmission rate in megabits per second of the SmartCard. You
set the rate for each card in a pair separately. For Ethernet cards,
possible values are: 10, 100. For Token Ring cards the value is 16.

Duplex Select the Duplex Mode for the test card. The test card will be
configured to run in a Full or Half Duplex mode (for Token Ring,
both TXI or TKP are allowed). The default is Half.
SmartApplications User Guide 63



64

Chapter 5: Set Up Tests
Configuring Test Ports
Protocol Select the protocol to use for the port. The protocol you select affects
other fields displayed on the tab. For example, if you select IP or
UDP, the SmartCard's IP and Router's IP fields are displayed, and
if you selected IPX, the Source Net and Destination Net fields are
displayed. If you are testing a router you must use either IP, UDP, or
IPX. Options such as the All 0s option refer to the packet contents
(excluding MAC addresses).

Note: You must use the same type of protocol within a port pair.
For example, you cannot configure the transmitting card with IP and
the receiving card with UDP.

SmartCard's IP Enter the IP address of the SmartCard displayed on this tab. The
SmartCard IP address should have the same network address as the
router port to which the SmartCard is connected, but with a different
host address.

Router's IP Enter the IP address of the router's port to which the SmartCard is
connected. If you are testing a switch, you can use the default value.

Note: If you change direction in the port selection area of the main
window, the Destination MAC and SmartCard MAC and
SmartCard's IP addresses on the card attributes tab for each port
remain unchanged. Verify that these fields reflect the correct
addresses.

Source Net The 4-byte network address of the transmitting card.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving card.

Destination MAC Once you define the test pair, you can specify the MAC addresses
used. Default addresses correspond to the port numbers. For
example, for Ports 1 and 2 the Destination MAC are 000000000001
and 000000000002 respectively. To specify a different address, enter
a different value in the field. Repeat this process until all the
addresses are specified correctly for your test pairs.

• Special conditions:
If you are testing a router, this is the MAC address of the local
router port.

• If you are testing a switch, this is the MAC address of the
destination SmartCard.

SmartCard MAC The MAC address of the sending SmartCard.

Table 5-6 Ethernet card attributes fields.

Field Description
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Flow Control Enables traffic flow control.

Note: This field only appears for 7x10 and GX-1405 SmartCards.
When this box is checked and the SmartCard receives a pause frame,
the card will stop transmitting for the number of slot times specified
in the pause frame. Default: OFF.

Auto Negotiation Auto-negotiation enables SmartApplications to achieve the best
possible mode of operation over a link segment by providing a means
for them to exchange information about their speed and duplex
capabilities over the link. There are four options available:

• None: No values are written for speed and duplex settings.

• Enable: Sets register 0 (zero) and register 4 to the user-selected
flow control, speed, and duplex (if applicable) settings. It sets
register 0 to Enable AN on this port.

• Disable: Sets register 0 and register 4 to the user-selected flow
control, speed, and duplex (if applicable) settings. It sets register
0 to Disable AN on this port. With this option, the port does not
participate in the AN protocol.

• Force: Sets register 0 and register 4 to the user-selected flow
control, speed, and duplex (if applicable) settings. It sets register
0 to Enable AN on this port and sets the appropriate bit to signal
a restart of the AN process.

Table 5-6 Ethernet card attributes fields.

Field Description
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Button

• Network IPs

Click this button to access the Network IPs window to define the contents of the RIP
(routing information protocol) packet. The RIP packet, sent out when testing over
multiple hops, updates the routing table.

Configuring Token Ring Ports
When you select a Token Ring port and the Show Card Attribute box is checked, the
appropriate Token Ring card attribute tab is displayed. Some of the fields are specific to
Token Ring
SmartApplications User Guide



Chapter 5: Set Up Tests
Configuring Test Ports
Token Ring Card Attribute Tab

This table lists and describes the Token Ring card attribute tab fields:

Table 5-7 Token Ring card attribute tab fields.

Field Description

Card Type Displays the type of SmartCard for that port, which in this case is
Token Ring.

Card Model Displays the model number of the card, such as TR-8405.

Signal Rate The transmission rate in megabits per second of the card. You set the
rate for each card in a pair separately. For Token Ring cards, possible
values are: 4, 16. This sets the rate for each cards in 1 to 1 tests.

Duplex Select the Duplex Mode. The test card will be configured to run in a
Full or Half Duplex mode (for Token Ring both TXI or TKP are
allowed). The default is Half.

Protocol Select the protocol to use for the port. The protocol you select affects
other fields displayed on the tab. For example, if you select IP or
UDP, the SmartCard's IP and Router's IP fields are displayed, and
if you selected IPX, the Source Net and Destination Net fields are
displayed. If you are testing a router you must use either IP, UDP, or
IPX. Options such as the All 0s option refer to the packet contents
(excluding MAC addresses).

Note: You must use the same type of protocol within a port pair.
For example, you cannot configure the transmitting card with IP and
the receiving card with UDP.

SmartCard's IP Enter the IP address of the SmartCard displayed on this tab. The
SmartCard IP address should have the same network address as the
router port to which the SmartCard is connected, but with a different
host address.

Router's IP Enter the IP address of the router's port to which the SmartCard is
connected. If you are testing a switch, this field can be the packet
contents.

Source Net The 4-byte network address of the transmitting card.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving card.
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This area of the Token Ring card attributes tab displays the current status of the Token
Ring port, such as if Early Token Release is enabled. It reflects the settings from the
Token Ring Properties window.

• Network IPs

Click this button to access the Network IPs window to define the contents of the RIP
(routing information protocol) packet. The RIP packet, sent out when testing over
multiple hops, updates the routing table.

• Property

Click this button to access the Token Ring Properties window to define the properties
of the Token Ring SmartCard.

Destination MAC For router testing, this is the MAC address of the local router port.
The SmartCard's MAC destination address must be set to be the
MAC address of the router port to which the card is connected.

For switch testing using 1 to Many or Many to 1 tests, this is the
MAC address of the destination SmartCard.

SmartCard MAC The MAC address of the SmartCard. MAC addresses are 48 bits
long, usually written as 6 bytes in hexadecimal. For the sake of
simplicity, set this to match the port number in the SmartBits system.
For example, port 1 would be 00 00 00 00 00 01 for the transmitter
and port 2 would be 00 00 00 00 00 02 for the receiver.

Note: If you selected IP or UDP for the Protocol field, the
following two fields (Smart Card’s IP and Router’s IP) also appear
on the tab.

Table 5-7 Token Ring card attribute tab fields.

Field Description
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To specify properties for the Token Ring port, click the Property button on a Token Ring
card attribute tab at the main window to access the Token Ring Properties window.

Token Ring Properties

This tables lists and describes the Token Ring Properties area fields:

Table 5-8 Token Ring Properties area fields.

Field Description

Send Monitor Polls This checkbox enables the card to send out standby monitor polls
in response to active monitor polls.

Allow Early Token
Release

For 16MHz operation only, this selection allows the SmartCard to
release a token prior to receiving its own transmitted frame back.
This can improve throughput, especially for small frames.

Use SRA The source routing field for a Token Ring frame is created by
selecting this checkbox. When selected, the fields for entering
source routing information become active.

If this option is selected, then the source address for the frame is
automatically modified before transmit to have its uppermost bit
set to indicate to the network that the frame contains source
routing information. You must ensure that the field contents are
correct, i.e. the length specification etc. must be valid in order to
be interpreted correctly by the network devices.
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The control bytes (first two bytes) in the Designators field is automatically updated when
you select any combination of options in this area of the window.

This tables lists and describes the Source Route Addressing area fields:

Port Select this radio button to configure the SmartCard port as a
Media Adapter Unit (MAU) port.

Station Select this radio button to configure the SmartCard port as a
station.

LLC test frames Select this radio button to use LLC test frames in the test.

SNAP frames Select this radio button to use SNAP frames in the test.

Table 5-9 Source Route Addressing area fields.

Field Description

Designators Defines how you want to route source packets. Enter hexadecimal
values directly into this field or make selections from the other
fields in the Source Route Addressing area. As you select other
fields the Designators field reflects the changes in hexadecimal
code for:

SRA field length Enter or select the length of the routing information field in bytes,
including the control field. Range: 2 to 30 bytes.

Largest frame
allowed

Enter or select the largest frame size that can be transmitted
between two communicating stations on a specific route.
Available values are: 516, 1470, 2052, 4472, 8144, 11407, 17800,
and Broadcast. The Broadcast setting is normally used in explorer
frames.

Table 5-8 Token Ring Properties area fields.

Field Description

SRA Length
Largest frame allowed
Address Control => 2-byte control field
Return Path
Direction
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Access Control This bit specifies the route through the network that the frame
should travel. The two options are:

• Broadcast
Select this radio button if you want the frame transmitted
along every route in the network to the destination station,
often resulting in many copies of the frame. 
When you select Broadcast, the Number of Hops field
displays. Select this option to test the Token Ring source
routing number of bytes that will be in the system offset.

• Non-Broadcast
Select this radio button if you want the segment number fields
to contain the specified route through the network that the
frame is to travel.

• System Offset
Enter the number of bytes offset by the source routing infor-
mation inserted by the DUT into each frame.

Return Path This bit defines a single path return or return through all available
paths. The two options are:

• All routes return
Select this radio button for a single path return.

• Single path return
Select this radio button for return through all available paths.

Direction This bit determines whether the of ring numbers and bridge
numbers in the routing information field are read from left to right
or right to left by the network devices.

• Outgoing SRA
Select this radio button for the bridge to interpret the routing
information field from left to right

• Return SRA
Select this radio button for the bridge to interpret the routing
information field from right to left.

Table 5-9 Source Route Addressing area fields.

Field Description
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Configuring ATM Ports
When you select an ATM port, the appropriate ATM card attribute tab is displayed. Some
of the fields are specific to ATM.

Summary of Steps to Configure an ATM Port

To configure an ATM port, from the ATM card attributes tab follow these steps:

1 Set up the line parameters. Click the Line Param button to access the Port Configura-
tion window.

2 Set up the protocol. Click the ELAN Param button to access the ELAN registration
window.

3 Add and configure at least one ELAN from the ELAN Registration window.

4 Specify the MAC addresses for the local router port and the SmartCard and the
remainder of the other options on the ATM card attributes tab.

The following is an example of the card attributes tab for an ATM SmartCard.
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This table lists and describes the ATM card attribute tab fields:

Table 5-10 ATM Card Attribute tab fields.

Field Description

Card Model Displays the model number of the card, such as AT-9025.

ELAN Name This field is displayed if you select SVC for the Connection Type
field. Select the name of the ELAN you want to use for the test. This
field is blank if you have not yet set up any ELANs. Click the
ELAN Param button to access the ELAN Registration window to
set up ELANs.

VPI-VCI This field is displayed if you select PVC for the Connection Type
field. Enter the contents in decimal or hexadecimal of the header
portion of the cell.

Connection Type The type of virtual circuit for the connection between the SmartBits
chassis and the device under test. This field controls the option in
the Encapsulation field. The two options are:

• SVC
Switched Virtual Circuit. The connection is established only
when needed.

• PVC
Permanent Virtual Circuit. The connection is permanently
established.

If you selected PVC for the Connection Type field, the Smart
Card’s IP and two fields also appear on the tab.

SmartCard's IP Enter the IP address of the SmartCard displayed on this tab. The
SmartCard IP address must have the same network number and
subnet address as the router port to which the SmartCard is
connected. Use the IP address of the outer port with its last digit
modified as the IP source address of the port.

Destination IP Enter the IP address of the receiving SmartCards.
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• Line Param

Click this button to access the Port Configuration window in order to specify physical
interface parameters such as framing and loopback, and to specify other ATM proto-
col information.

• ELAN Param

Click this button to access the ELAN registration window in order to specify LAN
emulation client information and to register ELANs.

Encapsulation This field is controlled by the Connection Type selection. If the
connection type is SVC, the encapsulation type is LANE 802.3
(Ethernet). If the connection type is PVC, the encapsulation type is
Classical IP.

If the Connection Type is PVC SNAP, the encapsulation type can be
either LANE 802.3 or Classical IP. SNAP (Subnetwork Access
Protocol) uses the subnetwork and performs data transfer,
connection management, and QoS selection.

Fill Pattern The protocol to use for the payload. If you selected PVC for the
Connection Type, the fill pattern is IP or UDP.

Destination MAC For switch testing using 1 to Many or Many to 1 tests, this is the
MAC address of the destination port.

For router testing, this is the MAC address of the local router port. If
you do not specify an address, you will get zero throughput. The
SmartCard's MAC destination address must be set to be the MAC
address of the router port to which the card is connected. For
example, a MAC destination is 08 00 02 06 89 22 for the transmitter
and 08 00 02 12 27 22 for the receiver.

SmartCard MAC The MAC address of the SmartCard. MAC addresses are 48 bits
long, usually written as 6 bytes in hexadecimal. For the sake of
simplicity, set this to match the port number in the SmartBits
system. For example, port 1 would be 00 00 00 00 00 01 for the
transmitter and port 2 would be 00 00 00 00 00 02 for the receiver.

Table 5-10 ATM Card Attribute tab fields.

Field Description
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In order to configure the ATM port, you must define the physical interface for the ATM
card at the Port Configuration window.

The Port Configuration window contains the following tabs:

• Line Params

Use this tab to specify physical interface parameters such as framing and loopback.

• SSCOP

This tab allows you to specify the UNI version and various timer values for SSCOP.

• UNI

This tab allows you to specify the UNI version and various timer values for UNI. Cur-
rently used for point-to-point only, the UNI configuration offers the standard user-
side timers and a special testing teardown timer.

• ILMI

Use this tab to define the method used by an ATM card to acquire its 20-byte ATM
address from the network device to which it is connected.

Line Params Tab

This table lists and describes the ATM Port Configuration Line Params tab fields:
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Table 5-11 ATM Port Configuration Line Params tab fields.

Field Description

Framing
Mode

Select to define the physical layer of the frame. The possible values for
this field are:

• AT-9025 25 Mbps SmartCard
ATM 25 Indicates direct cell mapping at 25.6 Mbps.

• AT-9015 DS1 SmartCard

• DS1 Cell - Maps the ATM cells directly into the DS1 frame
with no intermediate mapping.

• DS1 PLCP - Maps the ATM cells into PLCP frames and maps
the PLCP frames into the DS1 frame.

• AT-9020 E1 SmartCard

• E1 Cell - Maps the ATM cells directly into the E1 frame with
no intermediate mapping.

• E1 PLCP - Maps the ATM cells into PLCP frames and maps
the PLCP frames into the E1 frame.

• AT-9034 E3 SmartCard

• E3 Cell - Maps the ATM cells directly into an E3 G.832 frame
with no intermediate mapping.

• E3 PLCP - Maps the ATM cells into the PLCP frames and
maps the PLCP frames into an E3 G.751 frame.

• AT-9045 DS3 SmartCard

• DS3 Cell - Maps the ATM cells directly into the DS3 frame
with no intermediate mapping.

• DS3 PLCP - Maps the ATM cells into PLCP frames and maps
the PLCP frames into the DS3 frame.

• AT-9155C ATM OC-3c 155 Mbps

• OC3 - For SONET, OC-3c type of optical carrier line.

• STM1 - Enables the European STM 1 framing method (equiv-
alent to OC-3c)

• AT-9622 ATM OC-12c 622 Mbps SmartCard

• OC12 - For SONET, OC-12c type of optical carrier line. The
SmartCard maps the ATM cells directly into a SONET OC-
12c frame.

• STM4 - Enables the European STM-4 framing method (equiv-
alent to OC-12c). The SmartCard maps the ATM cells directly
into an STM-4 frames.
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Tx Clock
Source

This field does not apply to the AT-9025 SmartCard, which uses only an
internal clock. Specifies the clock against which you want to run the tests.
The possible values are:

• Internal
Uses an internally generated clock as the transmit clock.

• Loopback
Uses the recovered (received) clock as the transmit clock.

Loopback Specifies the type of loopback to be used. The possible values are:

• Disabled
No loopback is used. This is the normal operating mode of the device.

• Local
Loops card output back to the card's input.

• Remote
Traffic returns to the remote machine.

Errored Cells
Handling

Specifies the action to take for cells with errors. The possible values are:

• Drop Errored Cells
Drops all cells that have a header error as determined by the HEC
byte.

• Receive Errored Cells
Receives all cells even if they have errors.

• Receive and Correct Errored Cells
Receives and corrects all cells with single-bit header errors.

Table 5-11 ATM Port Configuration Line Params tab fields.

Field Description
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Buildout This field applies only to the AT-9015 DS1 and AT-9045 DS3
SmartCards. Select to change possible values for the electrical output of
the SmartCard to either:

1 Accommodate the length of the cable with which you are testing or,

2 Specify the amount of attenuation to apply to the signal.

AT-9015 DS1

• Cable Lengths

• <=133 Feet
Pulse shaping for cable lengths up to 133 feet.

• >133, <=266 Feet
Pulse shaping for cable lengths more than 133 feet and up to 266
feet.

• >266, <=399 Feet
Pulse shaping for cable lengths more than 266 feet and up to 399
feet.

• >399, <=533 Feet
Pulse shaping for cable lengths more than 399 feet and up to 533
feet.

• >533, <=655 Feet
Pulse shaping for cable lengths more than 533 feet and up to 655
feet.

• Buildout Attenuation Values

• -7.5 dB
Pulse shaping to generate -7.5 dB of attenuation.

• -15.0 dB
Pulse shaping to generate -15.0 dB of attenuation.

• -22.5 dB
Pulse shaping to generate -22.5 dB of attenuation.

AT-9045 DS3

• Cable Length

• <= 225 Feet
Pulse shaping for cable lengths up to 225 feet.

• >225 Feet
Pulse shaping for cable lengths more than 225 feet.

Table 5-11 ATM Port Configuration Line Params tab fields.

Field Description
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Line Coding This field applies only to AT-9015 DS1 and AT-9020 E1 SmartCards.
Select the type of encoding to be used for the line. The possible values are:

• AMI - Uses AMI line encoding.

• B8ZS - DS1 mode using B8ZS line encoding. (AT-9015 only).

• HDB3 - E1 mode using HDB3 line encoding (AT-9020) only.

Line
Framing

This field applies only to the AT-9015 SmartCard. Select the framing
mode for the physical layer. The possible values are:

• D4 - Uses D4 line framing.

• ESF - Uses Extended Super Frame line framing.

Cell
Scrambling

When checked, the payload of the cells is scrambled to facilitate cell
delineation. Most ATM devices require this feature to be on.

HEC Coset When checked, exclusive ORs the HEC with the bit pattern 0x55. Most
ATM devices require this feature to be on.

Idle Cell
Header

Specifies the header contents (4-bytes in hexadecimal) of the ATM idle
cell payload that is transmitted when no data cells are being transmitted.

Table 5-11 ATM Port Configuration Line Params tab fields.

Field Description
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SSCOP Tab

This table lists and describes the ATM Port Configuration SSCOP tab fields:

Table 5-12 ATM Port Configuration SSCOP tab fields.

Field Description

Max. CC Enter the maximum number of transmissions of a BGN, END, ER, to RS

PDU. Valid maximum value is 2 32 -1 (over 4 billion).

Max PD Enter the maximum number of SD PDUs that may be sent before sending a
POLL PDU. Value must be in the following range: 1 � Max PD � 25.

Max.
STAT

Enter the maximum number of list elements placed in a STAT PDU. Value
must be an odd number in the following range: 3 � Max STAT � 67.

Max.
Reseq

Enter the maximum receive resequencing queue depth in the following
range: 1 � Max Reseq � 16.

Max. Rx.
Windows

Enter the maximum number of unacknowledged SD PDUs that may be
received. Value must be in the following range: 1 � Max Rx Windows � 32.

Timer CC Enter the interval between transmission of BGN, END, RS, and ER PDUs as
long as acknowledgment to these PDUs has not been received.

Timer
Keep Alive

Enter the maximum time spent in the transient phase where POLL or STAT
PDUs may be lost.

Timer Idle Enter the maximum time spent in IDLE phase before reverting to transient
phase.
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SSCOP Tab Button

• Default

Resets all timers to the program-supplied default values.

UNI Tab

Timer No
Response

Enter the maximum time interval during which at least one STAT PDU must
be received. Default is 10,000 ms for UNI 3.0; 7,000 ms for UNI 3.1.

Timer Poll Enter the interval between transmission of POLL PDUs. Default is 100 ms
for UNI 3.0; 750 ms for UNI 3.1.

Note: Timer values must not be zero.

Table 5-12 ATM Port Configuration SSCOP tab fields.

Field Description
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This table lists and describes the ATM Port Configuration UNI tab fields:

Table 5-13 ATM Port Configuration UNI tab fields

Field Description

Version Values: 3.0 User or 3.1 User (for SmartBits ATM cards).

Txx The following table lists the UNI timers for port configuration:

Note: T398 and T399 will be utilized in a future release.

Teardown Enter the timer value (mandatory). This value is the time between teardowns
(call release requests) when resetting tests. A minimum of 10 milliseconds is
recommended to avoid test failure.

Note: Timer values must not be zero.

Timer Default Timeout State of Call Cause for Start and Stop

T303 4s Call initiated Start: SETUP sent.
Stop: CONNECT, CALL PROCEEDING,
or RELEASE COMPLETE received.

T308 30s Release Request Start: RELEASE sent.
Stop: RELEASE COMPLETE or
RELEASE received.

T309 10s Any stable state Start: SAAL disconnection. Calls in the
active state are not lost.
Stop: SAAL reconnected.

T310 10s Outgoing Call
Proceeding

Start: CALL PROCEEDING started.
Stop: CONNECT or RELEASE received.

T313 4s Connect Request Start: CONNECT sent.
Stop: CONNECT ACKNOWLEDGE
received.

T316 2 min. Restart Request Start: RESTART sent.
Stop: RESTART ACKNOWLEDGE
received.

T317 < T316 Restart Start: RESTART received.
Stop: Internal clearing of call references.

T322 4s Any call state Start: STATUS ENQUIRY sent.
Stop: STATUS, RELEASE, or RELEASE
COMPLETE received.
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• Default

Resets all timers to the program-supplied default values.

ILMI Tab
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This table lists and describes the ATM Port Configuration ILMI tab fields:

Table 5-14 ATM Port Configuration ILMI tab fields

Field Description

Method Select the method by which you want to register ILMI information.
The possible values:

• Dynamic registration
Assigns the SmartCard address using information from the
switch and from the SmartCard.

• Static registration
You define the 20-byte ATM address of the SmartCard. You
must also manually define the ATM address to the switch.

If you select Dynamic registration for the method, the following
fields appear:

• Cold Start Timer

• Register Timeout Timer

• End System Identifier (ESI)

If you select Static registration for the method, the following fields
appear:

• Prefix

• ESI

• Sel

Cold Start
Timer

Defines the interval between ILMI Cold Start TRAP requests sent to
the switch when no network prefix has been registered. Default is
5000 ms.

Register
Timeout Timer

Defines retransmission interval of address registration SET requests
when no acknowledgement is received from the switch.

End System
Identifier (ESI)

Six bytes in the 20-byte ATM address for identifying the end station
(SmartCard in this case) on a particular user-to-network interface.
The first five bytes are user-definable. SmartApplications
automatically sets the sixth byte to a value that represents a specific
SmartCard.

Note: Timer values must not be zero.

Prefix The first 13-bytes of the ATM address.

Sel This field is disabled.
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ILMI Tab Button

• Default

Resets all values to the program-supplied default values.

ATM ARP Tab

Table 5-15 ATM ARP field definitions

Field Definition

ARP Server ATM
Address

The ATM Address of the ATM ARP Server that must be running in
the system under test. This address must be a valid address of the
ATM ARP Server in order for Classical IP services to work
properly. Right-click on the field to copy/paste contents.

Inter ARP Gap The time in seconds between successive ARP request
transmissions. It is recommended to keep this value larger than 0 to
avoid flooding the ATM ARP server with excessive ARP requests.

Inter Call Gap The time in seconds between successive call setup for calls trying
to resolve the same destination IP address. It is recommended to
keep this value larger than 0 to avoid overloading the switching
device under test.

ARP Retries Number of ARP retries to attempt before giving up.
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Defining ATM ELAN Parameters

In order to configure the ATM port, you must add and register an ELAN if none exists.
Before you register an ELAN ensure that:

1 ILMI is up or has already obtained the ATM address of the SmartCard.

2 SSCOP/UNI is up (that is, SSCOP in Data Transfer Ready State, and SAAL in Connected
state) because the LEC has to set up SVCs to communicate with the LECS and LES.

You define and register ELANs at the ELAN registration window.
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This table lists and describes the ELAN Registration window fields:

Table 5-16 ELAN Registration Window fields

Field Description

ELAN Name Select the name of an ELAN that you want to join. The name must
exactly match (case sensitive) one of the ELAN names specified on
the device under test.

MAC Address The 6-byte MAC address of the LAN Emulation Client on the ATM
SmartCard.

ELAN Type LANE 802.3 is the only type currently supported.

ELANMTU Specify the maximum transmission unit of this ELAN.

ARP Retry Count Number of ARP retries to attempt before giving up.

Expected ARP
Resp. Time

Amount of time to wait before retrying to send another LE_ARP or
expiring (time out).

Init Method Select the ELAN initialization method to match the setting of the
device you are testing. The possible methods are:

• Normal
Default method. The LEC (LAN emulation client) on the ATM
SmartCard attempts to contact the LECS (LAN emulation client
server) at the default address specified by the ATM Forum to
obtain addressing information of the LES and BUS.

• LECS Direct
Allows you to directly input the ATM address of the LECS. Use
this field if LECS does not reside at the default address
specified by the ATM Forum.

• LES Direct
Allows you to input the ATM address of the LES. This method
can be used when no LECS service is available and the LES's
ATM address is known.

LEC/LES Address This field is greyed out if you select Normal for the Init Method
field. Enter the ATM address of the LEC or LES.
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Configuring WAN Ports
When you select a WAN port, the appropriate WAN card attribute tab is displayed. Some
of the fields are specific to WANs.

Part of configuring a WAN port involves specifying the physical parameters of the port,
which you specify at the WAN Port Setup window, including the following:

• Encapsulation

Use to select either Frame Relay or Point-to-Point Protocol (PPP).

• Line WN-3405, WN-3415 T1, or WN-3420 E1

Use to configure the physical characteristics of the port.

• EIA Leads (WN-3405 SmartCard only)

Use to select or deselect control signals on the V.35 line interface.

• LMI (Frame Relay only)

Use to select a Link Management Protocol signaling procedure.

• Address

Use to configure protocol addresses.
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This table lists and describes the WAN card attribute tab fields:

Table 5-17 WAN Card Attribute tab fields.

Field Description

Card Type Displays the type of SmartCard for that port, which in this case is Frame
Relay.

Card Model Displays the model number of the card, such as WN-3405.

Protocol Select the type of protocol the port should use. Options such as All 0s
refer to the packet contents. If you selected IP or UDP for the Protocol
field, the Smart Card’s IP and Destination IP fields appear on the tab.
If you selected IPX, the Source Net and Destination Net fields appear
on the tab.

Note: You must use the same type of protocol within a port pair. For
example, you cannot configure the transmitting card with IP and the
receiving card with UDP.

SmartCard's
IP

Enter the IP address of the SmartCard displayed on this tab. The
SmartCard IP address must have the same network number and subnet
address as the router port to which the SmartCard is connected. Use the
IP address of the outer port with its last digit modified as the IP source
address of the port.

Destination IP Enter the IP address of the receiving SmartCard.

Source Net The 4-byte network address of the transmitting card.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving card.

Destination
MAC

For switch testing using 1 to Many or Many to 1 tests, this is the MAC
address of the destination port.

For router testing, this is the MAC address of the local router port. If
you do not specify an address, you will get zero throughput. The
SmartCard's MAC destination address must be set to be the MAC
address of the router port to which the card is connected. For example, a
MAC destination is 08 00 02 06 89 22 for the transmitter and 08 00 02
12 27 22 for the receiver.

SmartCard
MAC

The MAC address of the SmartCard. MAC addresses are 48 bits long,
usually written as 6 bytes in hexadecimal. For the sake of simplicity, set
this to match the port number in the SmartBits system. For example,
port 1 would be 00 00 00 00 00 01 for the transmitter and port 2 would
be 00 00 00 00 00 02 for the receiver.
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Line Mode This field is the same as the Line Physical Mode field on the WAN Port
Setup window Line tab. If you change the value at the WAN Port Setup
window, the new value will be displayed here.

WN-3405 SmartCard

Select how you want to define the equipment mode (according to the
V.35 specification) within the Frame Relay User/Network interface.
Normally you configure the SmartCard as a DTE.

• DTE - User side (also referred to as CPE or Customer Premise
Equipment).

• DCE - Network side

WN-3415 SmartCard

Select how you want to define the equipment mode within the Frame
Relay User/Network interface. Normally you configure the SmartCard
as a CSU/DSU.

• CSU/DSU
Channel Service Unit/Data Service Unit. Also known as Customer
Premise Equipment. Defines the SmartCard port as residing on the
customer (subscriber) side of the T1/E1 connection.

• NET
Network side. Defines the SmartCard port as residing on the net-
work side of the T1/E1 connection.

WN-3420 SmartCard

Select how you want to define the electrical characteristics of the
T1 interface. Normally you configure the SmartCard as a CSU/
DSU.

• CPE
Channel Service Unit/Data Service Unit. Also known as Customer
Premise Equipment. Defines the SmartCard port to emulate the cus-
tomer (subscriber) side of the T1/E1 connection.

• NET
Network side. Defines the SmartCard port to emulate the network
side of the T1/E1 connection.

Table 5-17 WAN Card Attribute tab fields.

Field Description
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Line Rate This field is the same as the Line Rate (kbps) field on the WAN Port
Setup window Line tab. If you change the value at the WAN Port Setup
window, the new value will be displayed here. Select a line rate from
19.2 to 8192 Kbps. This value applies only to the V.35 interface of the
WN-3405 SmartCard. The value in this field sets the internal clock rate.

Encapsulation
Type

Select an encapsulation type to be used for the Frame Relay payload.
This field is the same as the Encapsulation Type field on the WAN Port
Setup window Address tab. If you change the value at the WAN Port
Setup window, the new value will be displayed here

• None - No encapsulation is used to send traffic. Select when source
and destination ports both use Frame Relay.

• Bridged - Select if the device you are testing is a bridge.

• Routed - Select if the device you are testing is a router.

DLCI The Data Link Connection Identifier for this PVC.

Table 5-17 WAN Card Attribute tab fields.

Field Description
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Defining WAN Port Parameters

You must define the line rate to use to transmit frames. The WAN Port Setup window
allows you to define this and other physical characteristics of the SmartCard port. This
screen illustrates the Line tab for the WN-3415 SmartCard.

The WAN Port Setup window contains these tabs:

• Line ��Use to configure the physical characteristics of the port.

• LMP ��Use to select a Link Management Protocol signaling procedure.

• EIA Leads (WN-3405 Frame Relay SmartCard only) ��Use to select or deselect
control signals on the V.35 line interface.

• Address ��Use to configure protocol addresses.

WAN Port Setup Line Tab (WN-3405)

Use this tab to configure the physical characteristics of your WN-3405 Frame Relay WAN
SmartCard port. After you specify the line mode (DTE or DCE), you must specify the line
encoding. If you use WAN SmartCards to both send and receive data, use the Line Clock
options to synchronize the sending SmartCard's data with the receiving SmartCard's clock.
Note: In a SmartCard test pair, you must configure one card as a DCE and one as a DTE.
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Line Physical Mode options

Select how you want to define the equipment mode (according to the V.35 specification)
within the Frame Relay User/Network interface. Normally you configure the SmartCard
as a DTE.

• DTE ��User side (also referred to as CPE or Customer Premise Equipment).

• DCE ��Network side

Line Clock options

Select these radio buttons to synchronize data with the clock. These are the line clock
options for the WN-3405 SmartCard:

• Tx Clock Src

Select the transmit clock source for the SmartCard. SmartWindow automatically
selects the External (default) radio button for Clock if you select DTE or the Inter-
nal radio button if you select DCE.

• Rx Clock Src

Select the type of clock source for the receiving SmartCard. If you select DTE Smart-
Window automatically selects the External radio button for the Line Clock. If you
select DCE you must select which source you want for the clock.

• Internal � The SmartCard provides the clock internally for the receiving Smart-
Card.

• External (SCTE - 113) � Circuit 113 by default, a function (signal) on a V.35
connector pin, provides the clock for the receiving SmartCard.

• Tx Clock Polarity

Select how you want the source port to transmit data in relation to clock timing. Since
the HDLC controller transmits data on rising edges only, when you change the clock
polarity to Falling Edge, the clock phase shifts 180 degrees with respect to the data.

• Rising Edge � Rising edge of the transmit clock coincides with the boundary of a
bit cell.

• Falling Edge � Rising edge of the transmit clock coincides with the middle (cen-
ter) of a bit cell. Select this option only if you use an external or isolated (buff-
ered) copy of the transmit clock.

• Rx Clock Polarity

Select the edge of the receive clock on which to sample received data.

• Rising Edge � samples received data on the rising edge of the receive clock.

• Falling Edge � samples received data on the falling edge of the receive clock.

• Line Rate (kbps)

Select a line rate from 19.2 to 8192 Kbps. This value applies to the V.35 interface.
The value in this field sets the internal clock rate.
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Other

Use these fields to specify other parameters such as line encoding and CRC. These are
other line parameters for the WN-3405 SmartCard:

• Encoding

Select the encoding type for the V.35 interface. Possible values:

• NRZ � Non-return to zero.

• NRZI � Non-return to zero inverted.

• Min. Flags Between Frames

Select the number of flags (7E hexadecimal pattern) to be inserted between transmit-
ted frames. The maximum value is 127.

• CRC Enabled

Check this box to enable HDLC frame CRC generation. This field applies to transmit-
ting traffic only. When receiving traffic, the SmartCard always checks for CRC char-
acters.

• Checked ��Enables the CRC (cyclic redundancy check). If checked, you can
select either 16-bit or 32-bit CRC generation.

• Unchecked ��Disables CRC generation. The SmartCard's receive path still looks
for CRCs at the selected (but greyed out) size.

• Zero Insertion/Deletion

Check this box to enable HDLC bit stuffing. This field applies to transmitting traffic
only. When receiving traffic, the SmartCard always performs bit unstuffing.

• Checked ��Enables HDLC zero-bit stuffing for transmitting data and zero-bit
unstuffing for receiving data, to help distinguish a byte of data from a flag byte.

• Unchecked ��Disables zero-bit stuffing and transmits raw (unencoded) data. The
SmartCard's receive path still performs bit unstuffing.
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WAN Port Setup Line Tab (WN-3415/WN-3420)

Click the Line tab to configure the physical characteristics of your WN-3415 Frame Relay
WAN SmartCard port:

In a SmartCard point-to-point test pair, you must configure one card as a CSU/DSU and
one as a NET. After you specify the line mode (CSU/DSU or NET), specify the line
encoding.

Line Physical Mode

Select how you want to define the equipment mode within the Frame Relay User/Network
interface. Normally you configure the SmartCard as a CSU/DSU.

• CSU/DSU

Channel Service Unit/Data Service Unit. Also known as Customer Premise Equip-
ment. Defines the SmartCard port as residing on the customer (subscriber) side of the
T1/E1 connection.

• NET

Network side. Defines the SmartCard port as residing on the network side of the T1/
E1 connection.
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Line Parameters

• Loopback

Specifies the type of loopback to be used.

• Disabled ��No loopback is used. This is the normal operating mode of the device.

• Local � Loops the SmartCard's output back to the SmartCard's input.

• Remote ��Loops the SmartCard's input back to the SmartCard's output.

• Buildout

Select to change the electrical output of the SmartCard to either 1) accommodate the
length of the cable with which you are testing or 2) specify the amount of attenuation
to apply to the signal.
For the WN-3420 only: Select the type of cable with which you are testing:
Coax Normal, Cat-5 Normal, Coax High Loss, Cat-5 High Loss.
Possible Buildout Cable Length Values:

<=133 Feet Pulse shaping for cable lengths up to 133 feet.

>133, <=266 Feet Pulse shaping for cable lengths more than 133 ft. and up to 266 ft.

>266, <=399 FeetPulse shaping for cable lengths more than 266 ft. and up to 399 ft.

>399, <=533 Feet Pulse shaping for cable lengths more than 399 ft. and up to 533 ft.

>533, <=655 FeetPulse shaping for cable lengths more than 533 ft. and up to 655 ft.

Possible Buildout Attenuation Values:
-7.5 dB Pulse shaping to generate -7.5 dB of attenuation.

-15.0 dB Pulse shaping to generate -15.0 dB of attenuation.

-22.5 dBPulse shaping to generate -22.5 dB of attenuation.

• Line Framing

Select the framing mode for the physical layer. Possible values:

• D4 ��Uses D4 (Super Frame) line framing.

• ESF ��Uses Extended Super Frame line framing.

• Line Encoding

Select the type of encoding to be used for the line. Possible values:

• AMI ��Uses AMI (Alternate Mark Inversion) line encoding.

• B8ZS ��Uses B8ZS line encoding. (WN-3415 only)

• HDB3 ��E-1 mode using HDB3 line encoding. (WN-3420 only)

• Transmit Clock source

Specifies the clock against which you want to run the tests.

• Internal ��Uses the SmartCard's internally generated clock as the transmit clock.

• Loop Timed ��Uses the received clock as the transmit clock.
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Other

Use these fields to specify other parameters such as line encoding and CRC.

• Encoding

Select the type of encoding to be used for the line. Possible values:

• NRZ � Non-return to zero.

• NRZI � Non-return to zero inverted.

• Min. Flags Between Frames

Select the number of flags (7E hexadecimal pattern) to be inserted between transmit-
ted frames. The maximum value is 127.

• CRC Enabled

Check this box to enable HDLC frame CRC generation. This field applies to transmit-
ting traffic only. When receiving traffic, the SmartCard always checks for CRC char-
acters.

• Checked ��Enables the CRC (cyclic redundancy check). If checked, you can
select either 16-bit or 32-bit CRC generation.

• Unchecked ��Disables CRC generation. The SmartCard's receive path still looks
for CRCs at the selected (but greyed out) size.

• Zero Insertion/Deletion

Check this box to enable HDLC bit stuffing. This field applies to transmitting traffic
only. When receiving traffic, the SmartCard always performs bit unstuffing.

• Checked ��Enables HDLC zero-bit stuffing for transmitting data and zero-bit
unstuffing for receiving data, to help distinguish a byte of data from a flag byte.

• Unchecked ��Disables zero-bit stuffing and transmits raw (unencoded) data. The
SmartCard's receive path still performs bit unstuffing.
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Channel Selection

Use the Channel Selection dialog box for Fractional T-1 and E-1. Select up to 24 channels
per SmartCard pair, which is the maximum number of 64 kbps circuits allowed on the T-1
line to transmit and receive frames. If you select all of the channels, the entire bandwidth
of the DS-1 line is used.

To select all channels

Click the Select All button.

To clear all channel selections

Click the Clear All button.

To select a range of channels

• Hold down the left mouse button and drag the mouse.

• Right click within the highlighted area. A popup menu appears from which you can
choose to check or uncheck the items in your selection.
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Synchronizing WAN SmartCard Clocks

In order to transmit data, you must synchronize both of the clocks in a SmartCard send/
receive test pair. Lack of synchronization can cause aborted frames and/or CRC errors
when transmitting flags because the receiving SmartCard can mistake the flags for a frame
or abort sequence.

These conditions can cause prevent or disrupt clock synchronization:

• Two SmartCards in a test pair not set to the same clock polarity

• Delays from mismatched cables

• Induced noise

• Internal delays

• Long cables (over 10 feet)

Note: Bit cell width shrinks as frequency rises. Since cable and internal delays are a
function of the cable length, they are constant.

In DTE mode, some routers may try to recover their transmit clocks based on incoming
data. If this occurs, the falling edges of the transmit clock (which is derived from the
receive clock) may have excessive jitter. To avoid this, select a Falling Edge for the
receive clock so that the sampling edge coincides with the middle of the bit cell period.
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WAN Port Setup LMP Tab

Click the LMP tab to display the following window:

The values that appear in these fields are industry-standard defaults. If you modify these
values, you can reset them back to the defaults with the Defaults button.

This table lists and describes the WAN Port setup LMP tab fields:

Table 5-18 WAN Port Setup LMP tab fields

Field Description

Link Management
Protocol

Select an LMP signaling method. The signaling method must match
the equipment to which you are connecting.

Logical Port Type Select the UNI DTE (User Side) or the UNI DCE (Network Side).
When connecting to a Frame Relay Switch, this would normally be
set to UNI DTE. If LMP is enabled and you configure the card as
CSU/DSU, set this field to UNI DTE. If you configure the card as
NET, set this field to UNI DCE.

DTE Full Polling
Cycle

Used to set the number of polling cycles to complete before a Full
Polling Status Inquiry Message is sent by the DTE.
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WAN Port Setup EIA Leads Tab (WN-3405)

These radio buttons correspond to the physical pins on the connector. This table lists and
describes the WAN Port Setup EIA Leads tab fields:

Monitored Events
Count

Used to set the number of Reliability Error events or In-Channel
Signaling Protocol Error events that can occur before a link is
considered inactive.

DTE Link
Integrity
Verification
Timer

Used to set the frequency in seconds that Status Inquiry Messages
are sent when configured as a DTE.

DCE Polling
Verification
Timer

Used to set the time that the interface waits for a Status Inquiry
Message before counting an error when configured as a DCE.

Table 5-19 WAN Port Setup EIA Leads tab fields.

Field Description

DCE Use these radio buttons to turn on or off Data Set Ready (DSR),
Clear to Send (CTS), Data Carrier Detect (DCD). These signals are
only applicable when the Physical Line Mode is set to DCE.

DTE Use these radio buttons to turn on or off Data Terminal Ready
(DTR), Request to Send (RTS). These signals are only applicable
when the Physical Line Mode is set to DTE.

Note: Test Mode (TM), Remote Loopback (RL), and Local
Loopback (LL) are currently not supported.

Table 5-18 WAN Port Setup LMP tab fields

Field Description
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WAN Port Setup Address Tab

Click the Addresses tab to display the following window:

This table lists and describes the WAN Port Setup Address tab fields:

Table 5-20 WAN Port Setup Address tab fields.

Field Description

MAC Address Enter a source MAC address for sending Ethernet protocol frames if
you selected Bridged (Ethernet) for the encapsulation type.

IP Address Enter an IP address for sending IP protocol frames.

Netmask Enter a subnet mask.

Gateway Enter the next hop IP address for the network.

Ping Target Enter the target IP address for the Ping packets.

Send Ping packet When checked, Ping packets will be sent to the Ping Target at the
rate in seconds that you enter in the a Ping Freq field.
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Send SNMP
packet

When checked, SNMP Management packets will be sent to the
Gateway at the rate (in seconds) that you enter in the SNMP Freq
field.

Send RIP packet When checked, RIP broadcast packets will be sent to out on all PVCs
on the above subnet at the rate (in seconds) that you enter in the RIP
Freq field.

Reply to all ARP
requests

When checked, ARP replies will be sent in response to all ARP
requests not destined for configured streams on the specified IP
address or the IP address configured for the card.

Table 5-20 WAN Port Setup Address tab fields.

Field Description
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WAN Port Setup Encapsulation (FR only) Tab

Click the Encapsulation (FR only) tab to display the following window:

This table lists and describes the WAN Port Setup Address tab:

Table 5-21 WAN Port Setup Encapsulation (FR only) tab fields

Field Description

Frame Relay Click to select Frame Relay.

PPP Click to select Point-to-Point Protocol (PPP).
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Router Testing
Testing routers with Smart Applications is very similar to how you test other devices,
however there are a few differences outlined here:

Switch testing

You select the test ports in the card attribute tab of the main window. Normally you can
use the default protocol settings. This is not true for router devices.

Router testing

SmartApplications needs more information since the DUT is routing the IP/IPX packets
routed to the destination port. To test routers successfully, you must manually edit the IP/
IPX headers by using the Network IPs window. There is an additional test you can
perform on routers called the Next Hop test.

Preliminary Setup for Router Testing

Before you test a router, you must do the following:

• Check the Router Test checkbox on the Preferences tab in the Test Setup window.

• If you also want to do a Next Hop test:

1Check the Next Hop Test box in the on the Preferences tab.

2Click the Network IPs button on the card attributes tab to access the Network IPs
window where you enter next hop IP addresses.

• Obtain the MAC and IP addresses of the involved router ports and enter them on the
card attribute tab on the main window.

Router Test Configuration Fields

The Router Test Configuration fields on the card attributes tab of the main window are
specifically for testing routers.
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This table lists and describes the Router Test Configuration fields:

At the beginning of each repetition of the test being run, every port involved in the test
sends out a packet to its test pair partner (using the test pair's MAC address). This should
cause the router under test to initiate an ARP exchange on the receiving ports to determine
their MAC addresses. All involved ports are set to recognize this ARP request when it
comes in (by using SmartCard triggers), and to respond with an appropriate ARP Reply
(by using the SmartCard Echo transmission mode). From that point, the router tables
should be updated and the test can continue.

The transmitting port routes IP, UDP or IPX packets to the receiving port via the router to
the MAC and IP addresses specified on the card attributes tab on the main window.

Table 5-22 Router Test configuration fields

Field Description

Protocol The protocol to use for the port. If you selected IP for the Protocol
field, the SmartCard's IP field appears. If you selected IP or UDP,
the Router’s IP fields appears. If you selected IPX, the Source Net
and Destination Net fields appear.

Note: For router testing, select use either IP, UDP, or IPX.

Smart Card’s IP This field appears when you select IP or UDP for the Protocol field.
The IP addresses are entered in this field using dotted decimal
notation. The SmartCard IP address must have the same network
address with a different host address as the router port to which the
SmartCard is connected. For example, a SmartCard IP is
192.168.100.2 for the transmitter and 146.72.1.2 for the receiver.

Router's IP This field appears when you select IP or UDP for the Protocol field.
The DUT IP address must be the IP address of the router port
connected to the card. For example, the DUT IP address for the
transmitter matches the router port IP, which is 192.168.100.1. Also,
the DUT IP for the receiver matches the IP of the connected router
port, which in this example is 146.72.1.1.

Source Net The 4-byte network address of the transmitting card.

Destination Net The 4-byte network address of the router port (for router testing) or
receiving card.

Destination MAC The SmartCard's MAC destination address must be set to be the
MAC address of the router port to which the card is connected.
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How the Next Hop Test Works
The Next Hop test tests a router's ability to recognize the next hop address and update its
routing table with this address. In Next Hop tests, all receiving ports act as virtual router
ports whose IP addresses you define in the Network IPs window.

How Next Hop Test Works

Figure 5-2. Diagram of Next Hop topology

At the start of each Next Hop test the receiving port sends to the router a RIP packet
containing the virtual router port (host) addresses that you defined on the Network IPs
window. These are the addresses of the networks you want the card to advertise. The router
then updates its routing table with these IP addresses (known as the “Learning Phase”).

Once the router's routing table is updated, the transmitting SmartCard sends packets
containing the host addresses from the Network IPs window to the router.

Setting Up Next Hop Tests

In order to use Next Hop tests, you must enter the network IPs of the virtual routers
involved by following these steps:

1 Check the Next Hop Test box in the Test Setup window.

2 At the SmartApplications main window, select IP or UDP or for the Protocol field.
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3 Click the Network IPs button from the card attribute tab. The Network IPs window is
displayed.

4 Enter up to 15 valid network IPs. The network IP is formatted as a RIP packet. The
first three bytes represent a network address for a Class C IP address. The last byte
represents the host address and is not modifiable.

Setting Up IP/UDP/IPX Protocols
When you select a Layer 3 protocol of IP, UDP, or IPX from the Protocol fields on a card
attribute tab, you must also specify IP addresses for additional fields that appear.

• If you select IP or UDP protocols these fields appear:

• SmartCards's IP

• Router's IP

• If you select IPX protocol these fields appear:

• Source Net

• Destination Net

The following SmartApplications main window illustrates some of the fields involved
with using IP, UDP, or IPX.

To set up a Layer 3 protocol address

1 For routers:
Determine the MAC and IP addresses for each router port you are using in the test.
Enter them into the Destination MAC and Router IP fields respectively. The MAC
addresses are in hexadecimal.
For switches:
You can use the default values.
Note: You must use the same type of protocol within a port pair. For example, you
cannot configure the transmitting card with IP and the receiving card with UDP.
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2 Enter the SmartCard IP. Use the same network address as the attached router port but
with a different host address.

Editing the IPX Frame Format

You can customize IPX frame formats to define distant MAC addresses with distant IPX
network addresses from the Card Attributes portion of the main window:

Follow these steps:

1 Select IPX from the protocol pull-down menu.

2 Click the Edit button. The IPX Header window displays:

3 Enter the appropriate hop type and socket values.

4 Close the IPX Header window by clicking the X button.

IPX requires that you provide a full address, including the distant network and the distant MAC.
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Editing the UDP Format

To customize the UDP format, follow these steps:

1 Select UDP from the protocol drop-down menu.

2 Click the Edit button. The UDP Header window displays:

3 Type the source (Src) and destination (Dst) port numbers in the corresponding UDP
fields.

4 Close the UDP Header window by clicking the X button.
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Example of Assigning Addresses for Protocols

Let us say you want to connect two SX-7410 SmartCards in Ports 1 and 2 to two ports of a
router. This example demonstrates how you might assign addresses for the protocols on
the card attribute tab.

1 Obtain the following addresses for the router's Port 1:
MAC address:00 00 A5 E3 91 00
IP address: 146.72.1.1

2 Enter the router's IP and MAC Destination on the appropriate port attribute tab.

3 Attach the SmartCard in Port 1 to the router's Port 1.

4 Assign the SmartCard's Port 1 IP address with the same network address but with a
different host address as the router's Port 1. SmartApplications automatically assigns
the SmartCard's MAC address.

SmartCard Port 1: 146.72.1.2
Smart Card MAC address:00 00 00 00 00 01

5 You obtain the following addresses for the router's Port 2:
MAC address: 00 00 A5 E2 91 00
IP address: 192.168.100.1

6 Enter the router's IP and MAC Destination on the appropriate port attribute tab.

7 Assign the SmartCard's Port 2 these addresses (for consistency):
SmartCard Port 2: 192.168.100.2
Smart Card MAC address:00 00 00 00 00 02

SmartApplications automatically issues the ARP exchanges to set up the router's ARP
table.

The SmartCard attribute tab for Port 1 would look like this:
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6
This chapter contains the following sections:

Section 1: Test Phases

Section 2: Viewing Test Results

Section 3: Viewing and Printing ASCII Text Report Files

Section 4: Viewing Log Contents
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Test Phases
Test Phases
When you start to run a test, the test goes through several phases.

Device Under Test Initialization
When the test starts, SmartApplications first sends out learning packets so that the switch
or bridge can learn which addresses are local and which addresses need to be forwarded.
After the learning sequence, the actual load testing begins.

Learning Phase

Some DUTs fail to update forwarding tables with the default number of packets (3) sent
from receiver to transmitter, transmitter to receiver. If the DUT does not update the
forwarding table correctly using the defaults, increase the number of learning packets to
send. To do this, select Test > Setup to access the Test Configuration tab. Increase the
number for the Learning Retries field. This field determines how many retries will be
used with a 1 second delay between retries before determining if a single packet can be
forwarded correctly. The default value is 3.

When you test routers, SmartApplications initiates an ARP exchange to up date the
router's ARP table before the learning phase.

Load Generation

The test now runs on the DUT (all selected ports run concurrently) starting with the first
packet size selected. The test is run according to the test methodology.
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Viewing Test Results
You can view test results on the Results window by:

• Individual test tab
View results by test as the test runs.

• Reports tab
View a report of the test once it finishes.

• Log tab
View a running record of all repetitions of each trial of all tests.

Once a test starts running, the Results window with the tab for that test is displayed. You
can also access the Results window by selecting File > View Results File from the main
window. See example below of the Results window for the Packet Loss test with a chart
created based on the results.

The Results window test tabs display test results as the test runs, until it finishes. The test
settings are displayed in the upper part of the window. The test results are displayed in the
status bar at the bottom of the window. To access the results of another test, click one of
tabs across the bottom of the window.

Note: For latency test results, SmartApps always measures and yields results for both
store and forward devices or for bit-forwarding (cut-through) devices regardless of the
DUT. When viewing results, use the result that is appropriate for your type of device.

When the testing is complete, the word Ready is displayed in the lower left hand corner
and the final results are be displayed in the lower right hand portion.
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Results Window Menu Options and Buttons

At the Results window you can perform the following actions through menu bar options or
the buttons at the top of the window:

Table 6-1 Results window menu bar options.

Action Menu bar option Button

Opens a previously saved Results file. Open Results File

Saves the information in the Results window to a file. Save Results File

Copies the information in the Results window to the
clipboard. You can then paste the information to a third
party software application such as MS Notepad � or MS
Excel�.

Copy Result

Prints the contents of the active tab on the Results window. Print Result

Stops the test from running. Stop Test

Begins running the test. Start Test

Opens the Chart Wizard window once you select some data
to chart.

Create Chart
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Results Window Status Bar fields

This table lists and describes the Results Window Status Bar fields:

Viewing Results of Previous Configurations

You can view and print the test results that you saved from other configurations while still
in the current configuration. Follow these steps:

1 From the main window, select File > View Results File. The Results window is dis-
played.

2 From the menu bar, select File > Open. Select the .vts file containing the test results
you want to view and click the Open button.

3 Click on a test tab to view test results, or one of the other tabs at the bottom of the
Results window.

Viewing and Printing Test Reports
SmartApplications provides two reports for each type of test that you run in one
SmartApplications session: a detail report and a summary report. Both types of reports
append results by packet size with each test trial. You can produce individual reports for
just one packet size.

Detail Reports

The detail report contains ALL results for each trial of each type of test that was run that
was run during the SmartApplications session. For every packet size tested,
SmartApplications appends the results of each trial to a report table that you can view

Table 6-2 Results window status bar fields.

Field Description

Frame size The size of the current frame being sent.

Trial The number of the current trial.

Rep The number of repetition for the current trial.

Passed The percentage of traffic that passed the test without any packet loss.

Current The rate at which the current trial/repetition is being run.

Failed The last rate at which packet loss occurred.

Note: Passed and Failed statuses are not used
in the Latency or Packet Loss test.
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Viewing Test Results
online or print. If you run all tests at once, the detail report contains results for all four
tests One report table can hold up to 16384 rows (equivalent to many reports). Detail
reports display, by packet size, test progress including current trial number, operation in
process (transmitting, receiving, retrieving data), current rate and passed rate. It also
displays approximate percent of completion.

Detail reports are available in two formats:

• Tabular (default)
Displays results in columns by frame size.

• Non-tabular
To change to the non-tabular report format, uncheck the Create Tabular Report box
on the Preference tab of the Test Setup window.

To view a detail report online

• Click the Reports tab of the Results window.

To print a detail report

• Select File > Print from the menu bar.

Note: For tabular reports only: You can only print data that is visible on your screen. If
the visible data on your screen exceeds physical page parameters, go to File > Page Setup
from the menu bar and adjust your margins.
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Summary Reports

SmartApplications also generates a summarized report for each type of test that you run in
a SmartApplications session. These reports summarize the results for each packet size run
for the test, similar to the Scott Bradner result format. For each test setup, at the end of a
trial SmartApplications appends the results by packet size to the summary report.

Note: You must use an editor such as MS Notepad� in order to view or print summary
reports.

To create a separate report for each packet size

• Rename the file on the Preferences tab in the Test Setup box.
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Viewing and Printing ASCII Text Report Files
You can print a detail report that contains the results of only one test at a particular packet
size. SmartApplications assigns the following default filenames to individual report files:

THROUGHP.nnn for Throughput.
LATENCY.nnn for Latency
PACKETLO.nnn for Packet Loss (Ethernet only)
BAKTOBAK.nnn for Back-to-Back (Ethernet only)

.nnn is the hexadecimal number representing the test frame size. For example, if you run
a Packet Loss test with a packet size of 64 bytes, the filename will be PACKETLO.040
where 040 is the hexadecimal for 64. You can change these default names (excluding the
file extension) on the Preferences tab in the Test Setup box.

Note:
1) Summary reports use the file extension .ndt.
2) If you run the same test again at the same packet size, SmartApps overwrites the first
detail report. To avoid this, rename the report filename before running the test again.

To print an individual test report (including a summary report)

1 Open an editor such as MS Notepad�.

2 Select the file you want to print using File > Open.

3 Select File > Print.
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Sample Throughput Report

Figure 6-1. Detail Report – Tabular Format

Figure 6-2. Detail Report - Non-tabular Format
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Viewing and Printing ASCII Text Report Files
Figure 6-3. Summary Report

Sample Latency Report

Figure 6-4. Detail Report - Tabular Format
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Viewing and Printing ASCII Text Report Files
Figure 6-5. Detail Report - Non-tabular Format

Figure 6-6. Summary Report
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Viewing and Printing ASCII Text Report Files
Sample Packet Loss Report

Figure 6-7. Detail Report - Tabular Format

Figure 6-8. Detail Report - Non-tabular Format
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Viewing and Printing ASCII Text Report Files
Figure 6-9. Summary Report

Sample Back-to-Back Report

Figure 6-10. Detail Report - Tabular Format
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Viewing and Printing ASCII Text Report Files
Figure 6-11. Detail Report - Non-tabular Format

Figure 6-12. Summary Report
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Viewing Log Contents
Each test that is run is displayed in a log that you can view from the Log tab of the Results
window. The log displays the detailed results of every repetition of every trial run. It is a
detailed running record of what happened during the test.

Note: Always check the test log to make sure that the test ran properly.

The following is an example of a Log:
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Test Scenario
7
What’s in this Chapter

This chapter contains the following sections:

Section 1: About the Scenarios

Section 2: Throughput Test Scenario

Section 3: Latency Test Scenario

Section 4: Packet Loss Test Scenario

Section 5: Back-to-Back Test Scenario
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About the Scenarios
The scenarios described provide successful sample test configurations for DUTs (routers
or switches). Although these examples may not match your test environment exactly, they
help demonstrate how you might run a test and what the results would look like. Naturally,
you would configure test configurations to your own needs.

Note: All of the scenarios described apply to either a router or switch. However, if the
device under test is a router, the Router Test box must be checked on the Preferences tab
of the Test Setup window.

Throughput Test Scenario
The Throughput test measures the fastest rate at which a device can forward frames
without error. If a single frame is dropped the test fails and the test is repeated at a lower
throughput rate.

Sample Test Configuration

In this example we selected Port 1 and Port 2 for testing as shown here:
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Throughput Test Scenario
In the card attributes tabs for the ports, the Destination MAC and SmartCard MAC
correspond to the sending and receiving port numbers, as shown here:

In this example the DUT is a switch. If we tested a router the Protocol field would have to
contain a Layer 3 protocol instead.

The following window displays the test configuration used for this test:

For this example, the test is set to start (Initial Rate) at 100%, the maximum rate to 100%,
the minimum rate to 50%, and the resolution to 1%. To save time the test is set for a
minimum of 64 bytes and a maximum of 128 bytes with a step size of 64. This will cause
two tests to run: one at 64 packets and a second at 128 packets.

The test will start running at 100% and fall back down from there if any packets are lost.
The minimum rate is 50%.
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Throughput Test Scenario
Note: The rates in this example were selected to minimize the number of tests run. RFC
1242 actually recommends frame sizes for Ethernet of 64, 128, 256, 512, 1024, 1280 and
1518 (the default sizes when the Use Custom box is checked).

Sample Test Results
The Results window for that test appears as soon as the test is started. The following is a
sample of the Results window for the Throughput Test:

• This trial failed.

• The rate at which the test failed.

• The current rate to which the test dropped.

Since we selected packet sizes of 64 and 128 bytes, only two tests are shown. The test
failed at an initial rate of 100%, dropped down to 80% for the next trial. For subsequent
trials normally a binary search rate that is between the successful and failed rates. In this
case that would be 40%, however since the Min. Rate for this test is set to 50% the rate
will not drop below that. The screen capture was taken when it dropped down to 50%.

The current rate to which
the test dropped.

The rate at which the test failed.
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Throughput Test Scenario
Sample Test Log
• Shows packets received

• Shows packets transmitted

• The following screen illustrates the log for the scenario we have been using.

Note:
1) Lines 1 through 6 represent one trial and one repetition.
2) The field that caused the iteration to fail (error) is indicated in red.

The difference in the number of packets
transmitted and received indicates packet loss.
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Throughput Test Scenario
Sample Test Report
The report summarizes the test.
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Latency Test Scenario
The Min. Rate field does not apply to Latency testing.

Sample Test Configuration
The following Test Configuration tab of the Test Setup window shows the settings used
in this scenario:

We will test with 64-byte packets and 128-byte packets. Each trial will last 10 seconds.
Learning Packets will be sent once before each test.

These settings show an Initial Rate of 50% a Step Rate of 25% and a Max Rate of 100%.
These settings will cause six tests to run. The tests will run with 64-byte packets at 50%,
75% and 100%, then with 128-byte packets at 50%, 75% and 100%.

The Latency test does not step down in percentage of transmission. For example, if we set
Initial Rate to 100%, Minimum Rate to 50% and Step Rate to 25%, the test will only run at
100%.

Note: Rates in this example were selected to minimize the number of tests run. RFC 1242
actually requires a minimum of 20 repetitions (Number of Trials) with a recommended
stream duration of at least 120 seconds. The recommended frame sizes for Ethernet are 64,
128, 256, 512, 1024, 1280 and 1518 (the default sizes when the Use Custom box is
checked).
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Sample Test Results Window for Latency
The sample Results window below shows the Latency test in progress. Test results are
displayed for both Cut Through and Store and Forward devices. Use the measurement that
is appropriate for your type of device.

The 64-byte tests are complete at 50%, 75% and 100%. The latency time is 1.2
microseconds for all rates. The 50% test with 128-byte packets is also complete with a
latency of 1 microsecond.

In the status bar at the bottom of the window displays current activity:

• Transmitting 4 of 10 seconds

• Frame size being transmitted (128 bytes)

• Current trial count (1 of 1)

• Current rate (74.99%)

Note: Passed and Failed statuses are not used in the Latency test.
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Packet Loss Test Scenario
This test measures the percentage of frames lost by the DUT that should have been
forwarded.

Sample Test Configuration
In this example, the Packet Loss test ran with the following settings:

We have left the Packet Size to Test set to start with 64 byte packets, increase by 64 bytes
after each test, and stop when the packet size is equal to or greater than 128. This results in
six trials: 64-byte packets sent at 50%, 75% and 100%, and 128-byte packets sent at 50%,
75% and 100%.

Note: Rates in this example were selected to minimize the number of tests run. The
recommended frame sizes for Ethernet are 64, 128, 256, 512, 1024, 1280 and 1518 (the
default sizes when the Use Custom box is checked).
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Packet Loss Test Scenario
Sample Results Window
Based on the settings in this scenario, the following Results window was displayed:

In this example the first test ran at 50% with 64-byte packets and no packet loss. The loss
rate (shown in the 1 to 1 column) shows 0% lost.

The second test ran at 75% with 64-byte packets, and 11.555% of the packets transmitted
were lost. In the third test, 16.239% of the packets transmitted were lost.

Results Window for a Router

We also ran this test on two 10 Mbps routers joined by a 56 kbps link. Therefore, the
packet loss was very high, as shown below:
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Back-to-Back Test Scenario
Back-to-Back tests the buffering capability of the device under test.

Sample Test Configuration
In this example, the back-to-back test ran with the following settings:

The test is set to run five, 5-second trials per test. The testing will start at the 50% rate and
increase in 25% steps to a maximum of 100%. It starts with 64-byte packets and increases
by 64 bytes in each test to a maximum of 128-byte packets.

Note: Rates in this example were selected to minimize the number of tests run. RFC 1242
actually recommends at least 50 trials with a required minimum duration of 2 seconds
with frame sizes for Ethernet of 64, 128, 256, 512, 1024, 1280 and 1518 (the default sizes
when the Use Custom box is checked).
SmartApplications User Guide 139



140

Chapter 7: Test Scenario
Back-to-Back Test Scenario
Sample Results Window
Based on the settings shown above, this test produced the following Results window:

This Results window shows the number of frames in the longest burst that the DUT
handled without dropping a packet. In this scenario we used a jumper wire to connect the
two SmartCards under test. Therefore the results shown here only represent the maximum
number of frames of that size that can be transmitted at the test rate.
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This glossary describes the terminology, abbreviations, and acronyms introduced in this
guide, as well as terms based on networking technology and standards.

Acronyms and Abbreviations

Acronym /
Abbreviation

Definition

AMI Alternate Mark Inversion.

ATM Asynchronous Transfer Mode. Transfer mode in which
information is organized into cells.

CPE Customer Premise Equipment.

CRC Cyclic Redundancy Check.

CSU Channel Service Unit.

CTS Clear to Send.

DCD Date Carrier Detect.

DLCI Data Link Connection Identifier.

DSR Data Set Ready.

DSU Data Service Unit.

DTR Data Terminal Ready.

DUT Device Under Test.

ELAN Emulated Local Area Network. A group of ATM and legacy
devices registered with the LES that constitute a logical
network.

ESI End System Identifier.
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FIFO First in-first out.

GPS Global Positioning System.

ILMI Interim Local Management Interface. Discovers and registers
ATM addresses of attached hosts.

IP Internet Protocol. Works in conjunction with TCP and is
usually identified as TCP/IP.

IPX Internetwork Packet Exchange.

LAN Local Area Network. Designed to move data between stations
within a campus.

LEC Lan Emulation Client. A device such as a server, switch, or
workstation that performs ATM signaling and control
functions while communicating with other devices in an
ELAN. Every LEC CLient has an ATM address and a MAC
address.

LECS LAN Emulation Configuration Server. Provides mapping
information about ELANs on the ATM network that a LEC
may join.

LES LAN Emulation Server. Registers the MAC addresses of each
LEC on the non-ATM LAN and resolves the MAC address to
an ATM address.

LIFO Last in-first out.

LMP Link Management Protocol.

NRZ Non-return to zero

NRZI Non-return to zero inverted.

PCB Printed Circuit Board.

PPP Point-to-Point Protocol.

PVC Permanent Virtual Circuit. A dedicated channel between
endpoints through an ATM network used for long-term data
transfer.

RFC Request For Comments. Document series used as the primary
means for communicating information about the Internet.

Acronym /
Abbreviation

Definition
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RIP Routing Information Protocol.

RTS Request to Send.

SMB SmartBits.

SNAP Subnetwork Access Protocol.

SRA Source Route Addressing.

SVC Switched Virtual Circuits. Switched Virtual Circuit: A
connection established through signaling with user-defined
endpoints when the call is initiated.

UDP User Datagram Protocol. Connectionless transport layer
protocol in the TCP/IP protocol stack.

VCI/VPI Virtual Channel Identifier/Virtual Path Identifier. A
connection in the form of a channel which has been
successfully initialized and on which data is ready to be
transmitted and received. Provides mapping information for
routing cells from a source to destination.

WAN Wide Area Network

Acronym /
Abbreviation

Definition
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Terminology

Back-to-Back test

Tests the buffering capability of the device under test (DUT).

bi-directional

Port pairs transmitting simultaneously in both directions, as in full duplex operation.

card

In this manual, refers to any SmartCard or printed circuit board (PCB) that resides within
a SmartModule or MiniModule.

frame

A data pattern that a stream transmits.

hub

The SmartBits chassis that contains a SmartCard or module.

iteration

An iteration is when SmartApplications, while maintaining the frame size, varies the
transmission rate based on the last failed rate. The resolution and number of repetitions
determines the accuracy of results.

latency

Delay between the time a device receives a frame and the time that frame is forwarded out
the destination port.

MAC address

A 6-byte IEEE identifier for hardware devices, sometimes called a hardware address.

Next Hop test

Tests a router’s ability to recognize the next hop address and update its routing table with
this address.

Packet Loss test

Measures the percentage of frames lost by the device under test (DUT) that should have
been forwarded.

port

On a SmartBits chassis, the port on a SmartCard or module.

slot

On a SmartBits chassis, a slot is where the SmartCard or module is inserted.

stream

An engine which defines where and how to transmit a frame repeatedly.

test

Refers to the test (such as Throughput or Latency) run for a particular frame size.
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Throughput test

Tests the fastest rate at which a device can forward frames without error.

trial

One set of iterations for a specific fame size and varying transmission rates. Tests use trials
to determine the optimal rate of traffic for that frame size.
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